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Welcome to Sprint

We are committed to bringing you the best wireless technology available, and we 
built our network right from the start, so no matter where you are on the network, 
all your services will work the same.

When it comes to mobile connectivity, the Sprint Mobile Broadband USB modem 
offers more freedom than ever before. No wires, no cables, just access to your data 
when you need it. The power of the Internet and company data is truly at your 
fingertips.

This guide will familiarize you with our technology and with Sprint Connection 

ManagerSM software with location-enhanced Local Search and your new 
Sprint Mobile Broadband USB modem through simple, easy-to-follow 
instructions.

Welcome and thank you for choosing Sprint.
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Introduction

This User’s Guide introduces you to Sprint service and all the features of your new 
wireless Sprint Mobile Broadband USB modem. It’s divided into six sections:

� Section 1:  Basics of Your Sprint Mobile Broadband USB Modem

� Section 2:  Installing the Sprint Mobile Broadband USB Modem

� Section 3:  Using the Sprint Mobile Broadband USB Modem

� Section 4:  Technical Specifications and Regulatory Information

� Section 5:  Safety Information and Terms & Conditions

� Section 6:  Glossary and Index

Throughout the guide, you’ll find tips that highlight special shortcuts and timely 
reminders to help you make the most of your wireless USB modem and services.

The Table of Contents and Index will help you locate specific information quickly. 
The Sprint Connection Manager software includes extensive online help to guide 
you through the steps to use each feature.

You’ll get the most out of your new Sprint Mobile Broadband USB modem if you 
read each section of this document. However, if you’d like to get right to a specific 
feature, simply go to that page. Follow the instructions in that section and you’ll 
be ready to use your device in no time.

Tip: You can view this guide online or print it to keep on hand. If you’re viewing it online, 
simply click a topic in the Table of Contents, a page number in the Index, or any page 
or section reference. The PDF automatically displays the appropriate page.



Section 1

Basics of Your 
Sprint Mobile Broadband USB Modem
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Sec tion 1A

Introducing the Sprint Mobile Broadband 
USB Modem

In This Section

� Your Sprint Mobile Broadband USB Modem

� CDMA Networks

� Package Contents

� About This Guide

This section introduces the basic features and functions of your Sprint Mobile 
Broadband USB modem, what is included with your device, and how to use this 
guide to get you started.
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Your Sprint Mobile Broadband USB Modem

The Sierra Wireless AirCard® 595U USB modem is a dual-band wireless USB 
modem. It enhances the functionality of your mobile or desktop computing 
devices by adding wireless data.

This device allows you to do the following (subject to feature availability), without 
using a landline phone or network:

� Connect to the Internet, VPN, and corporate networks

� Send and receive large email messages

� Use Location-Based Services (on Windows® only)

� Conduct video-conferencing

� Access streaming, real-time media

� Play games online

Your Sprint Mobile Broadband USB modem fits into a USB slot (available on most 
notebook and desktop PCs).

CDMA Networks

The Sprint Mobile Broadband USB modem operates over a type of wireless 
network called CDMA (Code Division Multiple Access).

To use the Sprint Mobile Broadband USB modem, you need an account that gives 
you access to the CDMA network. Some features described in this manual may not 
be available with your account. For details of the services and accounts available, 
contact Sprint (page 27).

There are CDMA networks that operate in the frequency bands supported by 
the Sprint Mobile Broadband USB modem throughout North America and parts of 
Latin America, Asia, and New Zealand. However, each service provider operates a 
network that covers a limited geographical area within the overall CDMA coverage 
area.

The fee for service may be higher when you are roaming (connecting to a network 
other than Sprint).

Sprint has “roaming” agreements with other service providers, so that you can get 
service outside of the coverage area of the network. (There may be additional 
charges for roaming service.)
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CDMA technology provides a variety of connectivity features, depending on your 
Sprint account (actual speed depends on the network conditions):

� 1xEV-DO Rev. A (Sprint Power VisionSM) supports Internet connections with data 
rates up to 3.1 Mbps (downlink from the network) and 1.8 Mbps (uplink to the 
network). Average data rates are 450-800 kbps (downlink from the network) 
and 300-400 kbps (uplink to the network).

� 1xEV-DO Rev. 0 (Sprint Power Vision) supports Internet connections with data 
rates up to 2.4 Mbps (downlink from the network) and 153 kbps (uplink to the 
network). Average data rates are 400-700 kbps (downlink from the network) 
and 40-80 kbps (uplink to the network).

� 1X (Sprint Vision) supports Internet connections with data rates up to 153 kbps.

You can set Sprint Connection Manager to automatically establish a packet data 
connection (Sprint Power Vision or Sprint Vision) when it starts. 

You can also set Sprint Connection Manager so that, without running 
Sprint Connection Manager, you can make a Sprint Power Vision or Sprint Vision 
connection simply by starting whatever application you want to use (such as your 
Web browser or email application).

If the packet data connection is lost, the connection is restarted automatically. 
This provides an “always-on” network connection (as far as permitted by network 
coverage). Once the connection is established, you can open your browser and 
connect to any Web site that is accessible through the Internet, or access other 
Internet services (such as email).

The connection is “active” when data transmission is occurring. If data 
transmission stops for a period of time (determined by the network), the 
connection becomes “dormant.” (See page 35.)

Tip: More information about CDMA networks is available on the CDMA Development 
Group Web site, www.cdg.org.

Tip: For pointers on optimizing your settings, see “How can I optimize my settings to 
achieve the fastest speeds and conserve data when accessing my corporate 
network?” on page 78.

http://www.cdg.org
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Package Contents

Your Sprint Mobile Broadband USB modem package contains the following 
components:

� Sprint Mobile Broadband USB modem by Sierra Wireless (Model AirCard 595U)

� Rechargeable modem battery

� Docking station with attached cable

� Getting Started guide

� Installation CD containing the Sprint Connection Manager software, warranty 
information, and this document

About This Guide

This user's guide is designed to provide you with all the information you need to 
install and use your Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U).

� Section 1 (which you are reading) gives you an overview of the Sprint Mobile 
Broadband USB modem (AirCard 595U).

� Section 2 provides step-by-step instructions for installing the Sprint Mobile 
Broadband USB modem and Sprint Connection Manager software (page 13).

� Section 3 provides step-by-step instructions on using the device (page 29).

� Section 4 provides electrical, radio frequency, and other parameters of the 
Sprint Mobile Broadband USB modem for those who require technical 
information, as well as regulatory information (page 87).

� Section 5 provides important safety and liability information and the Terms and 
Conditions of use for the Sprint Mobile Broadband USB modem (page 101).

� Section 6 include a glossary (page 125) and index (page 129).

Note: The comprehensive Getting Started guide that comes with the 
Sprint Mobile Broadband USB modem should be sufficient for most 
installations.
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Sec tion 1B

Getting Started With Your Sprint Mobile Broadband 
USB Modem

In This Section

� Getting Started

� System Requirements

� The Sprint Mobile Broadband USB Modem Software

� Care and Maintenance

This section describes the basics of getting started with your Sprint Mobile 
Broadband USB modem, and how to look after your device.
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Getting Started

Before you begin using your Sprint Mobile Broadband USB modem, you must:

1. Check that your computer has the system requirements listed below (“System 
Requirements”).

2. Install the Sprint Connection Manager software, located on the installation 
CD, onto your PC. See page 16.

3. Start Sprint Connection Manager.

4. Insert the battery into the Sprint Mobile Broadband USB modem, and insert 
the device into your computer; this installs the drivers for the device.

5. Charge the battery for approximately two hours.

6. Activate your Sprint account and configure the Sprint Mobile Broadband USB 
modem to use your account (unless the device has been preactivated). See 
page 22.

System Requirements

The Sprint Mobile Broadband USB modem is supported on:

� Windows Vista.

� Windows XP (Home and Professional versions).

� Windows 2000 with Service Pack 1 or later (Service Pack 4 is recommended), 
with high encryption support. (See “High Encryption Requirements” on page 9.)

� Mac OS X (supported through the WatcherTM Lite software—available from the 
Sierra Wireless Web site at  www.sierrawireless.com/support).

CAUTION: Do not insert the Sprint Mobile Broadband USB modem into the USB 
slot until you have installed and run the Sprint Connection Manager 
software, and the software displays “No device.”

http://www.sierrawireless.com/support
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To install and run the Sprint Mobile Broadband USB modem and accompanying 
Sprint Connection Manager software, you will need the minimum system 
resources shown in the following table.

High Encryption Requirements

Depending on your configuration, an IOTA (Internet Over The Air) session may 
automatically start as part of the installation/activation process. IOTA requires 
high-security 128-bit encryption to establish a secure Internet connection to the 
CDMA network. (For more information, see “Data Provisioning [IOTA]” on 
page 25.)

If you are running Windows Vista or Windows XP, your computer should already 
include high-security 128-bit encryption.

If you are running Windows 2000 with Internet Explorer
1. Ensure you have installed the Windows 2000 High Encryption Pack: in Internet 

Explorer, select Help > About Internet Explorer.

If you see “Cipher Strength: 128-bit,” then the High Encryption Pack is 
installed. Proceed to step 2.

If the High Encryption Pack is not installed, download and install it 
(www.microsoft.com/windows2000/downloads/recommended/encryption).

2. If your version of Internet Explorer is earlier than 5.5, download and install the 
latest version (www.microsoft.com/windows/ie/downloads).

If you are running Windows 2000 with Netscape Communicator

Ensure your version of Netscape Communicator is 4.7 or higher.

To verify that your version supports 128-bit encryption:

1. In Navigator, select Help > About Navigator. 

– or –

In Netscape Communicator, select Help > About Communicator.

USB slots One USB slot. (If your computer’s USB slot is vertical, use the 
docking station. Do not use the Sprint Mobile Broadband USB 
modem in a USB hub or in a USB slot on a keyboard.)

Optical drive CD-ROM

Memory 32 MB

Disk space 32 MB

www.microsoft.com/windows/ie/downloads
www.microsoft.com/windows2000/downloads/recommended/encryption
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2. See the section “Contains encryption software from RSA Data Security, Inc.” 

If the next paragraph states “This version supports U.S. security,” you have 
128-bit security.

If the paragraph states that you have International security, you have 40-bit 
security. Download a version that supports 128-bit security.

The Sprint Mobile Broadband USB Modem Software

The Sprint Mobile Broadband USB modem comes with the following software:

� Sprint Connection Manager, which allows you to manage the device’s actions 
and monitor your connections

� The driver software that forms the interface between the Sprint Mobile 
Broadband USB modem and your Windows operating system

Before you insert the Sprint Mobile Broadband USB modem for the first time, you 
must install and then run the Sprint Connection Manager software. The driver 
software is installed the first time you insert the device into your computer.

Detailed instructions are provided beginning on page 16.

Care and Maintenance

As with any electronic device, the Sprint Mobile Broadband USB modem must be 
handled with care to ensure reliable operation. Follow these guidelines in using 
and storing the device:

� The device should fit easily into your USB slot. Forcing the device into a slot may 
damage the connector pins.

� Protect the device from liquids, dust, and excessive heat.

� When not installed in your computer, store the device in a safe place.

� Remove the device before storing or transporting your computer.

� When inserting or removing the device, always grip it by the sides rather than 
the end.

� To avoid the risk of explosion, use the same battery model when replacing the 
battery. Properly dispose of the used battery.

� The device’s USB connector is adjustable to three positions. Do not force the 
hinge past the last position—this may break the connector. For more 
information, see the picture on page 17.
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� Do not use the device with a handheld computer; it is designed only for 

notebook or desktop computers running Windows® Vista, XP, 2000, or 
Mac OS X.

� Do not handle or operate the device while driving or operating a vehicle. Doing 
so may distract you from properly operating the vehicle. In some states and 
provinces, operating communication devices while in control of a vehicle is a 
criminal offense.



12



Installing the Sprint Mobile 
Broadband USB Modem

Section 2
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Sec tion 2A

Installing the Software

In This Section

� Getting Started

This section explains how to install your Sprint Connection Manager software.

The process may vary, depending on the operating system that you are running.
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Getting Started

Before you can use your device, you must first install the device’s software and 
configure the device for your computer. The installation process consists of:

� Software installation - Installing the Sprint Connection Manager software on 
your computer (described in this section).

� Insertion of the rechargeable battery into the device

� Device insertion and driver installation - Starting the Sprint Connection Manager 
software and inserting the device, which automatically installs the drivers on 
your computer.

� Device activation and provisioning - Activating your Sprint account and 
configuring the device to use your account. (See “Setting Up Service” on 
page 21.)

1. If the installation CD is not already in your CD-ROM drive, insert it.

The CD should autostart.

If the CD does not autostart, select Start > Run and enter d:\SCMInstaller.exe, 
where d is the drive letter of your CD-ROM drive.

Note: For comprehensive instructions on installing the Sprint Connection 
Manager software and activating the device, see the Getting Started guide.

CAUTION: Do not insert the device into your computer’s USB slot before installing the 
software.

Note: Windows Vista and Windows 2000 users: You must log in with 
administrative privileges to install the software and drivers.
Windows XP users: You may need to log in with administrative privileges, 
depending on your Windows configuration.
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2. Use the Next and Back buttons to navigate through the wizard, noting the 
following:

� You must select I accept the terms in the license agreement to indicate your 
acceptance of the terms of the license agreement to proceed with the 
installation.

� Use the default settings for the Destination Folder unless you have special 
requirements and an advanced understanding of PC configuration. (The 
Destination Folder dictates where the software is installed.)

3. When the “Installation Complete!” window is displayed, click Finish.

4. Run Sprint Connection Manager.

(Double-click the program’s icon [ ] on your desktop.)

5. Wait for Sprint Connection Manager to start up and display “No device...”.

6. Slide the front panel off the Sprint Mobile Broadband USB modem.

7. Hold the battery so that the side with two white arrows faces up and the gold 
contact points on the end of the battery line up with the gold contact points 
on the Sprint Mobile Broadband USB modem. Insert the battery into the 
device.

8. Slide the front panel onto the device until the panel clicks into place.

9. Slide the lever on the bottom of the device in the direction indicated by the 
triangle to release the device's USB connector.

10. Adjust the USB connector to the desired angle. (The USB connector is 
adjustable to three positions—approximately 90, 135, and 160 degrees. Do 
not force the hinge past the last position—this may break the connector.)

Warning: To avoid the risk of explosion, use the same battery model when replacing 
the battery. Properly dispose of the used battery.
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11. Insert the device into your computer’s USB slot.

Alternatively, you can attach the docking station to your computer’s USB slot, 
and insert the device into the docking station.

When the device is properly inserted, the Power LED is lit, and the battery starts to 
charge.

Windows detects the device and installs the drivers for it. This may take a few 
minutes. Once completed, Sprint Connection Manager should display 
“Disconnected.”

12. Charge the battery for approximately two hours.

After you’ve charged the battery, proceed to configure the device to use your 
account (if it was not preactivated); see “Activating and Using Sprint Service” on 
page 22. If your device is preactivated, after you’ve charged the battery, you are 
ready to connect to the network; to learn about using the software, see “Your 
Sprint Mobile Broadband USB Modem: The Basics” on page 31.

Note: If your computer’s USB slot is vertical, use the docking station. 
Do not insert the device into a USB hub or a USB slot on a keyboard.

Warning: If the orientation of your computer’s USB slot or the thickness of your 
computer are such that pressure is applied to the device’s end or side (as 
shown by the red circles in the drawings below), you may damage the device 
or your computer. In such cases, do not insert the device directly into your 
computer’s USB slot; use the docking station instead.

Note: If you have an older version of Sprint Connection Manager and are 
experiencing problems during installation, use the Add/Remove Programs 
Utility (see page 54) to remove the older version of Sprint Connection 
Manager. Then reinstall the current version of Sprint Connection Manager 
from the Installation CD.
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Section 2B

Inserting and Removing the Sprint Mobile Broadband 
USB Modem

In This Section

� Inserting the Sprint Mobile Broadband USB Modem

� Removing the Sprint Mobile Broadband USB Modem

This section describes how to properly insert the Sprint Mobile Broadband USB 
modem and remove it from your PC.
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Inserting the Sprint Mobile Broadband USB Modem

To insert the Sprint Mobile Broadband USB modem into a notebook or desktop 
computer:

1. Holding the Sprint Mobile Broadband USB modem by its sides, insert the 
device into the USB slot of your computer.

Alternatively, you can attach the docking station to your computer’s USB slot, 
and insert the device into the docking station.

When you insert the Sprint Mobile Broadband USB modem, the following should 
occur:

� The first time the device is inserted, Windows detects the device and installs 
the drivers for it. This may take a few minutes. Once completed, 
Sprint Connection Manager should display “Disconnected.” To connect to the 
network, click GO.

� If sound effects are enabled, the PC beeps.

The Sprint Mobile Broadband USB modem is powered as soon as you insert it.

Removing the Sprint Mobile Broadband USB Modem

To remove the Sprint Mobile Broadband USB modem:

1. Exit Sprint Connection Manager if it is open (page 44).

2. Remove the device from your computer’s USB slot by gripping both sides of 
the device and pulling straight out.

Note: If your computer’s USB slot is vertical, use the docking station. Do not insert 
the Sprint Mobile Broadband USB modem into a USB hub or a USB slot on a 
keyboard.

IMPORTANT! When inserting or removing your device, always grip the device by its 
sides. Gripping the device by its end may damage the device.
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Sec tion 2C

Setting Up Service

In This Section

� Activating and Using Sprint Service

� Preactivated Device

� Non-preactivated Device: Activation Wizard

� Data Provisioning (IOTA)

This section walks you through setting up service for your Sprint Mobile 
Broadband USB modem, after you have installed the Sprint Connection Manager 
software (page 16) and inserted the Sprint Mobile Broadband USB modem.
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Activating and Using Sprint Service

Before using your Sprint Mobile Broadband USB modem, you must have a 
Sprint wireless network account set up. The process of setting up an account is 
called activation.

When the Sprint Mobile Broadband USB modem is inserted and 
Sprint Connection Manager is started, it will detect whether the device has been 
configured with an account (“preactivated”). If it has not, the Activation Wizard 
starts automatically.

Preactivated Device

If you received your Sprint Mobile Broadband USB modem in the mail or 
purchased it at a Sprint Store, it probably has already been activated.

To prevent unauthorized use, preactivated devices may have been set with a 
security lock. If so, Sprint Connection Manager displays the message “Device 
locked.”

To unlock your Sprint Mobile Broadband USB modem:

1. Click the  icon. (If is not visible, click  to expand Sprint Connection 
Manager.)

2. In the Enter User Lock Code window, enter your four-digit lock code, and click 
OK. For security purposes, the code is not visible as you type.

After unlocking your preactivated Sprint Mobile Broadband USB modem, it is 
ready for use. See “Using the Sprint Mobile Broadband USB Modem” on page 29.

Tip: If you can’t recall your lock code, try using the last four digits of either your 
Social Security number or your device’s phone number (MDN), or try 0000. If 
none of these work, call Sprint Customer Service at 1-888-211-4727.
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Non-preactivated Device: Activation Wizard

If your device is not preactivated, please see the Getting Started guide included 
with your device.

If your Sprint Mobile Broadband USB modem is not preactivated, 
Sprint Connection Manager automatically detects that no account has been 
configured when you run it for the first time. It then runs the Activation Wizard to 
guide you through the activation and configuration process.

To set up your account, you will be contacting Sprint.

Before you call Sprint, have these things ready:
� A phone

� Your Sprint Mobile Broadband USB modem

� Your Social Security number

� Your driver’s license number

� The city and state where the device will be primarily used

� A pen and paper to write down your account information. Your package 
includes a printed Getting Started guide, where you can record this 
information.

When you call Sprint, Sprint Customer Service will help you select your service 
plan and guide you through the activation process. They will also provide you with 
this information:

� Your device’s activation code (gives you access to configure the account)

� Your device’s phone number (MDN)

� Your device’s MSID (Mobile System ID) code, used for WLNP (Wireless Local 
Number Portability) and to determine whether you are “home” or “roaming”
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Stepping Through the Activation Wizard
If the Activation Wizard has not started automatically:

1. Ensure the Sprint Mobile Broadband USB modem is inserted, and 
Sprint Connection Manager is running. If Sprint Connection Manager is not 
running, select:
(Windows Vista or Windows XP) Start > All Programs > Sprint > Sprint Mobile 
Broadband (Sierra).
(Windows 2000) Start > Programs > Sprint > Sprint Mobile Broadband (Sierra).

Sprint Connection Manager should display “Disconnected.”

2. If Sprint Connection Manager displays “Device locked,” unlock the device 
(page 52).

3. If Sprint Connection Manager displays “Device powered off,” power the device 
on (page 38).

4. Start the Activation Wizard: select MENU > Settings > Sprint Vision - Sierra 
Wireless > Activation Wizard.

Once the Activation Wizard is running:

1. To begin activation of the Sprint Mobile Broadband USB modem, click Next.

2. Call Sprint at the phone number listed on the screen. Click Next.

3. Give the account representative your ESN (Electronic Serial Number) or MEID 
(Mobile Equipment IDentifier) number as displayed by the Activation Wizard. 
Enter the activation code provided by the account representative and 
click Next.

4. Enter the phone number (no spaces or hyphens) and, if not the same value as 
the phone number, the MSID value given by the account representative, and 
then click Next.

A confirmation window will be displayed.

5. Confirm with the service representative that the information is correct. If it is, 
click Yes. If it isn't, click No, and re-enter the information.

6. Click Finish to close the Activation Wizard.

7. Wait a few moments for the Sprint Mobile Broadband USB modem to 
automatically reset. Depending on your configuration, an IOTA session may 
automatically start. (See “Data Provisioning [IOTA]” on page 25.)

After Sprint sets up your account on the network, your Sprint Mobile Broadband 
USB modem should be configured and ready for use.
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Data Provisioning (IOTA)

IOTA (Internet Over The Air), supported by some service providers (including 
Sprint), is an automated feature to perform account setup for you by making a 
connection to the CDMA network and using a secure Internet connection to 
download account parameters to your Sprint Mobile Broadband USB modem. To 
make this secure connection, IOTA requires that your computer support 128-bit 
encryption. (See “High Encryption Requirements” on page 9.)

Depending on your configuration, the first time Sprint Connection Manager 
detects the activated device, an IOTA session may automatically start, during 
which status messages (“Updating User Profile…”) are displayed.

After this first activation, there may be changes to your account that require 
updating the parameters in the Sprint Mobile Broadband USB modem. If this is 
needed:

1. In the Device Info & Diagnostics window (page 72), click Update Data Profile. 
(If this button is not displayed, remove and reinsert the device.)

2. In the IOTA Provisioning window, click Yes.

Your Sprint Mobile Broadband USB modem then retrieves the updates to your 
data services account. Once the updates are successful, Sprint Connection 
Manager is displayed (“Disconnected”). You can now connect to the network.
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Section 2D

Getting Help

In This Section

� Visiting the Sprint Web Site

� Contacting Sprint Customer Service

� Troubleshooting

This section describes where you can find more information on Sprint services, 
options, and troubleshooting problems you have encountered.
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Visiting the Sprint Web Site

Stop by www.sprint.com and log on to get up-to-date information on 
Sprint services, options, and more.

You can also:

� Review coverage maps.

� Access your account information.

� Add additional options to your service plan.

� Check out frequently asked questions.

� And more.

Contacting Sprint Customer Service

You can reach Sprint Customer Service by:

� Logging on to your account at www.sprint.com.

� Calling us toll-free at 1-888-211-4727.

� Writing to us at Sprint Customer Service, P.O. Box 8077, 
London, KY  40742.

Troubleshooting

The Online Help for Sprint Connection Manager (see page 49) includes 
descriptions of most common error messages. Look in the Contents under 
Troubleshooting.

For help with other problems:

� See “Troubleshooting Tips” on page 80.

� Consult the Sierra Wireless Web site at www.sierrawireless.com, where you will 
find an extensive knowledge base that can be searched to address most 
problems, and the Installation Troubleshooting wizard (in the Support & 
Download section).

� Contact Sprint as noted above.

http://www.sprint.com
http://www.sprint.com
http://www.sierrawireless.com
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Sec tion 3A

Your Sprint Mobile Broadband USB Modem: The Basics

In This Section

� Sprint Connection Manager

� Starting Sprint Connection Manager

� Starting Sprint Connection Manager Automatically

� Sprint Connection Manager Window

� Connection States

� System Tray Connection States

� Determining the Type of Coverage

� Location-Based Services

� Powering the Device On and Off

� Controlling the Sprint Connection Manager Window

� Launching a Sprint Power Vision or Sprint Vision Connection

� Viewing the Amount of Data Transferred

� Ending a Connection

� Online Help

� Displaying Your Phone Number

� Security

� Accessing Links

� Uninstalling the Sprint Connection Manager Software

Your Sprint Mobile Broadband USB modem is packed with features that simplify 
your life and expand your ability to stay connected to the people and information 
that are important to you. This section guides you through the basic features of 
your Sprint Mobile Broadband USB modem.
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Sprint Connection Manager

Sprint Connection Manager is the application that allows you to manage and 
monitor the high-speed Sprint Power Vision (1xEV-DO) and Sprint Vision (1X) 
connection to the Sprint network. You use Sprint Connection Manager to:

� Determine your signal strength and other network connection parameters (page 33).

� Initiate data calls (page 45).

� Access Location-Based Services (page 40).

� View call statistics (page 70) and messages (page 35).

� Customize features and options (page 60).

Starting Sprint Connection Manager

To start Sprint Connection Manager:

1. Ensure the Sprint Mobile Broadband USB modem is inserted into your 
computer’s USB slot.

2. Double-click the program’s icon ( ) on your desktop, or, from the Start menu 
on your Windows desktop, select:
(Windows Vista or Windows XP) All Programs > Sprint > Sprint Mobile Broadband 
(Sierra).
(Windows 2000) Programs > Sprint > Sprint Mobile Broadband (Sierra).

When Sprint Connection Manager is running, it places an icon ( ) in the system 
tray, usually at the right end of the taskbar. (See page 39.)

Tip: Without running Sprint Connection Manager, you can make a data connection 
simply by starting whatever application you want to use (such as your Web browser 
or email application). Prerequisites: you must have previously selected, in 
Sprint Connection Manager, Enable NIC for data connections and GO automatically when 
ready (page 64). However, to make use of other features of the Sprint Mobile 
Broadband USB modem (including Location-Based Services), you must run 
Sprint Connection Manager.

Tip: You can also set Sprint Connection Manager to launch automatically 
whenever your device is detected. (See “Starting Sprint Connection 
Manager Automatically” on page 33.)
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Starting Sprint Connection Manager Automatically

To set Sprint Connection Manager to start automatically (whenever your device is 
detected):

� From the General option of the Settings window (page 61), select Launch 
Connection Manager automatically.

Sprint Connection Manager Window

The text (for example, “Connected” shown in the screenshot above) and icon(s) in 
Sprint Connection Manager indicate the connection state (page 35), and also (only 

when disconnected) the lock state (page 50) (locked  or unlocked ).

Note: Changes to this setting apply only after you restart Windows.

Tip: You can also set the connection to launch automatically whenever 
available. (See “GO automatically when ready” on page 64.) These settings 
provide an “always-on” connection, as long as you have network coverage.

Exit

Establish/Show/

Menu

hide
details cancel a

MinimizeMessage area Indicator area

connection
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Sprint Connection Manager may display, depending on the connection state, 
some of the following icons:

CDMA network signal strength, indicated by the number of bars.

The ToolTip indicates the type of coverage you have (for example, 1X 
and/or 1xEV-DO), and the signal strength, in dBm.

You are roaming. Roaming charges may apply.

If this icon is flashing, you are in a non-preferred roaming area, and you 
may not be able to complete your calls.

Tip: You can change the roaming option ("Roam Mode"; for example, to 
disable roaming, select Sprint), and also enable the Roam Guard feature (from 
the Sprint Vision Settings window; page 63).

1xEV-DO Rev. A transmit/receive icon: a data connection is active.

The up arrow is animated (for example: ) when data is being 
transmitted to the network.

The down arrow is animated (for example: ) when data is being 
received from the network.

1xEV-DO Rev. 0 transmit/receive icon: a data connection is active.

The up arrow is animated (for example: ) when data is being 
transmitted to the network.

The down arrow is animated (for example: ) when data is being 
received from the network.

1xEV-DO (Rev. 0 and Rev. A) transmit/receive icon: the data connection 
is dormant. The up and down arrows are gray.

1X transmit/receive icon: a data connection is active.

The up arrow is black and animated when data is being transmitted to 
the network.

The down arrow is black and animated when data is being received 
from the network.

1X transmit/receive icon: the data connection is dormant. The up and 
down arrows are gray.
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Sprint Connection Manager has the following buttons and text:

� Menu or the  button — Displays the Sprint Connection Manager menu 
(page 56).

�  — Expands Sprint Connection Manager and displays the amount of data 
transferred (when Connected), or, when disconnected, the lock status of your 

device (locked  or unlocked ).

�  (Displayed when Sprint Connection Manager is expanded) — Hides the 
amount of data transferred and the lock status of your device.

�  (upper right corner of the window) — Minimizes Sprint Connection Manager 
(page 44).

�  — Exits Sprint Connection Manager.

� GO — Starts the Sprint Power Vision or Sprint Vision connection (page 45).

� Stop — Ends the connection (visible when a connection is established).

Connection States

Sprint Connection Manager can display various connection and interaction states, 
including:

� No device

� Initializing

� Updating User Profile… (See “Data Provisioning [IOTA]” on page 25.)

� Searching for service...

� Disconnected

� Connecting

� Connected

� Connected to NDIS

� Device locked

� Device powered off
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If you initiate Location-Based Services (page 40), a window may display 
“Searching.”

No device

Sprint Connection Manager did not detect the Sprint Mobile Broadband USB 
modem. The GO button is unavailable.

Insert the Sprint Mobile Broadband USB modem. If it is already inserted, remove 
and reinsert it; wait a few moments. If this message is still displayed, uninstall 
(page 54) and reinstall Sprint Connection Manager, or contact Sprint (page 27).

Initializing

Sprint Connection Manager is attempting to establish communication with the 
Sprint Mobile Broadband USB modem.

Searching for service...

Sprint Connection Manager is determining whether 1X or 1xEV-DO service is 
available. If this message persists, see page 82.

Disconnected

Sprint Connection Manager is ready to make a connection to the network or to 
use Location-Based Services. The GO button is available; the signal strength icon 

( ) and the roaming icon ( ) (if you’re roaming) are visible. If Sprint Connection 

Manager is expanded, the lock icon (  or ) is visible.

Note: The system tray icon also indicates the connection state (page 16).
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To connect to the network, click GO.

Connecting

Sprint Connection Manager is establishing a connection to the network.

Connected

The connection is established. In addition to the signal strength icon ( ) and the 

roaming icon ( ) (if you’re roaming), the transmit/receive icon (  for 1xEV-DO 

Rev. A;  for 1xEV-DO Rev. 0;  for 1X) is also displayed.

If you expand Sprint Connection Manager ( ), the amount of data transferred is 
shown. (See note on page 48.)

To end the connection, click Stop.

Connected to NDIS

This message applies only if you have selected Enable NIC for data connections 
(page 64). For a description, see “Connected” (above).
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Device locked

The device is locked, so that others cannot use the device and your account. To use 
most of the features, you must unlock the device (page 52).

Device powered off

The device has been powered off (through Menu > Power Off Modem). To use the 
device, select Menu > Power On Modem.

For more information, see “Powering the Device On and Off” on page 42.

Searching

The device is requesting GPS satellite information from the network.
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System Tray Connection States

Sprint Connection Manager has an associated icon ( ) that appears in the 
system tray. The icon reflects the connection state.

Clicking the system tray icon toggles between displaying and minimizing 
Sprint Connection Manager.

Right-clicking the icon displays the shortcut menu (page 58).

Sprint Connection Manager is not ready to connect to the network. 
Your Sprint Mobile Broadband USB modem is either locked 
(“Device locked”; page 38), or not detected (“No device”; page 36), 
or powered off (“Device powered off”; page 38).

Disconnected — Sprint Connection Manager is ready to make a 
connection to the network (page 36), or
Connecting — Sprint Connection Manager is making a connection 
to the network (page 37).

Connected — Connection is established to the network; data 
transfer is in progress (page 37).

Dormant — Connection is established, but no data transfer is 
taking place.
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Determining the Type of Coverage

The ToolTip over the signal strength indicator ( ) indicates the type of coverage 
you have (for example, 1X [synonym of 1xRTT] or 1xEV-DO):

Location-Based Services

Location-Based Services (Location & Search Services) allow you to query the 
network for information on points of interest that are near your current location. 
The network automatically determines your current location. All you have to do is 
specify the type of business that you are looking for (for example, a restaurant or 
hotel).

To use Location-Based Services:

� In Sprint Connection Manager, click Menu > Location & Search Services.

Tip: The type of coverage is also displayed in the lower left part of the Device Info 
& Diagnostics window under “Network Service” (page 73).

Note: If the menus and windows (page 40 and page 66) related to Location-Based 
Services are unavailable in Sprint Connection Manager, see “Location-Based 
Services Don't Seem To Be Available” on page 84.
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If the GPS fix is successful or if data from a recent GPS fix is available, then the 
Sprint Nextel Location & Search window  is displayed. The bottom part of the 
window displays location information (latitude and longitude) of your device, and 
the time that the location information was acquired.

From the Location & Search window, enter or select the type of item you want to 
find, and click Go.

If more than a preconfigured period of time has elapsed since the last time you’ve 
submitted a location search, a window is displayed asking whether you want to 
get an updated (GPS) position fix. (Depending on your account, you may be 
charged for each position fix or after you have performed a certain number of 
fixes.) If your current location is different from where you submitted your last 
location search, click Yes.

Note: Sprint Connection Manager uses Microsoft Internet Explorer to display the 
results of Location-Based Services.
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Internet Explorer opens and displays the results of your search query. In the 
search results of some mapping and search services, you can right-click your 
location to get additional information—for example, driving instructions.

From the Location & Search window, you can submit additional searches.

From the Settings window, you can specify the settings for Sprint Location 
Services (page 66).

Powering the Device On and Off

If you are using your Sprint Mobile Broadband USB modem in an aircraft, hospital, 
or other environment where the device may cause interference, you can power 
the device off (without removing it from your USB slot), and still use other 
functions of your computer.

This also allows you to conserve your notebook computer’s battery and charge the 
device’s battery.

To power the device off:

1. Close any active data connection (page 49).

2. Select MENU > Power Off Modem.

When the device is powered off, the menu option switches to Power On Modem, 
and Sprint Connection Manager displays the message “Device powered off .”

To power the device on:

� Select MENU > Power On Modem.
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Controlling the Sprint Connection Manager Window

Expanding Sprint Connection Manager

Sprint Connection Manager has two views: compact and expanded.

Compact view:

To expand Sprint Connection Manager, click . Sprint Connection Manager now 
also displays the amount of data transferred during the current connection, and 

(only when disconnected) the lock state of the device (locked  or unlocked ).

Expanded view:

To change back to the compact view, click .



44 Section 3A: Your Sprint Mobile Broadband USB Modem: The Basics

Minimizing Sprint Connection Manager
To save space on your screen for other programs, you can minimize Sprint Connection 
Manager:

� Click  (in the upper right corner of Sprint Connection Manager).

– or –

Click the Sprint Connection Manager icon  in the system tray.

– or –

Right-click the system tray icon and select Close Sprint Mobile Broadband.

You can use the system tray icon to monitor the connection state (page 39).

Restoring Sprint Connection Manager
To restore Sprint Connection Manager when it is minimized:

� Click the Sprint Connection Manager icon  in the system tray. 

– or –

Right-click the system tray icon and select Open Sprint Mobile Broadband.

Exiting Sprint Connection Manager
To exit Sprint Connection Manager:

� In Sprint Connection Manager, select Menu > Exit, or click the  button,

– or –

Right-click the Sprint Connection Manager icon  in the system tray and, 
from the shortcut menu, select Exit.

If you have not selected Enable NIC for data connections (page 64) and a connection 
is in progress, a window is displayed asking whether you want to disconnect the 
call. To end the connection and close Sprint Connection Manager, you must click 
Yes.

Tip: You can set Sprint Connection Manager to start minimized. (See “Start in 
system tray” on page 62.)

Tip: You can prevent Sprint Connection Manager from minimizing by setting 
Always on top (page 62).
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Sprint Connection Manager closes, and the Sprint Connection Manager icon 
disappears from the system tray.

Launching a Sprint Power Vision or Sprint Vision 
Connection

To launch a connection:

� In Sprint Connection Manager, click GO. (If GO is unavailable, see “GO Button Is 
Unavailable” on page 82.)

When the connection is successfully established, the network welcome screen 
appears (unless you have turned off the display of the welcome screens; see 
“Always show Welcome Screens” on page 64).

Sprint Connection Manager displays “Connected” or “Connected to NDIS” 
(page 37).

You can now use your Web browser, perform data transfers, and so on.

Note: If you have selected Enable NIC for data connections (page 64), after exiting 
Sprint Connection Manager, you are still connected to the network (data 
may still be transferred). To manage the connection, use the Windows 
network connection icon in the system tray.

Note: A connection is automatically established if, after you select Menu > 
Location & Search Services, a GPS fix is successfully acquired.



46 Section 3A: Your Sprint Mobile Broadband USB Modem: The Basics

To monitor the status of the connection, you can use the text (page 35) and icons 
(page 33) in Sprint Connection Manager, and the icon in the system tray (page 39). 
You can also view the amount of data transferred (page 48).

Roam Guard

The Roam Guard feature, when enabled, displays a warning message if you are 
roaming and a data connection is established or about to be established. The 
message reminds you that roaming rates may apply.

From the window with the warning message, you can:

� Turn off the warning message for this data session only ("Do not ask again 
during this data session").

� Continue with the data connection ("Roam") (in which case you may be subject 
to roaming rates).

� End the data connection ("Cancel").

Tip: You can optionally specify which application to automatically launch when 
the connection is established. (See “Auto-launch Upon Network 
Connection” on page 47.)
You can also set the connection to launch automatically whenever 
available. (See “GO automatically when ready” on page 64.) If you also set 
Sprint Connection Manager to launch automatically (see “Launch 
Connection Manager automatically” on page 62), this can provide an 
“always-on” connection, as long as you have network coverage.
You can have a connection established automatically—without running 
Sprint Connection Manager—simply by starting whatever application you 
want to use (such as your Web browser or email application). Select Enable 
NIC for data connections and GO automatically when ready (page 64). However, 
Sprint Connection Manager and its icon in the system tray won’t be 
available for you to monitor the status of the connection. Location-Based 
Services also won’t be available.
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To turn on the Roam Guard feature:

1. From the Sprint Vision option of the Settings window, ensure Roam Mode is 
set to Automatic.

2. Select Roam Guard.

To permanently turn off the Roam Guard feature:

� From the Sprint Vision option of the Settings window, clear Roam Guard.

Auto-launch Upon Network Connection

You can optionally specify which application to automatically launch when a 
Sprint Power Vision or Sprint Vision connection is established.

To specify which application to automatically launch:

1. Ensure Sprint Connection Manager is running and not locked (page 51).

2. Ensure that your Sprint Mobile Broadband USB modem is not powered off 
(page 38).

3. Select MENU > Settings > Sprint Vision - Sierra Wireless.

4. Select Auto Launch.

5. In the Auto-Launch Options window, select one of the following:

� None — Do not auto-launch any application.

� Website — Auto-launch Internet Explorer. In the URL field, specify the Web 
site (such as http://www.sierrawireless.com) you want to view on 
connection.

� Microsoft VPN (PPTP) Connection — Auto-launch a Windows VPN connection. 
Type in the address of the VPN connection, or, from the drop-down list, 
select the VPN connection.

� Application (VPN client, etc.) — Auto-launch an installed VPN program, or any 
other program. In the field, enter the path to the program, or use the 
Browse button to locate the program.

The changes are applied the next time you launch a connection.

Note: This feature is available only if Roam Mode is set to Automatic (from the 
Sprint Vision option of the Settings window; page 63).

Note: This feature functions only when Sprint Connection Manager is running.
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Viewing the Amount of Data Transferred

To view the number of bytes sent/received during the current connection:

� If Sprint Connection Manager is not expanded, click the  button.

The number of bytes sent/received during the current connection is displayed, in 
three significant digits (such as 581 kb, 1.23 Mb, 1.81 Mb).

Once you end the connection, the figures reset to zero.

To hide the part of Sprint Connection Manager that displays this information, 

click the  button.

Note: Even though the number of bytes sent and received is displayed while the 
connection is running, this is not necessarily the actual amount of data 
being transmitted across the network. Do not use this information to estimate 
billing.
If you have selected Enable NIC for data connections (page 64), after exiting 
Sprint Connection Manager, you are still connected to the network. Data 
may still be transferred.
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Ending a Connection

To end a connection:

� In Sprint Connection Manager, click Stop.

If you have not selected Enable NIC for data connections (page 64) and you exit 
Sprint Connection Manager while a connection is in progress, a window is 
displayed asking whether you want to disconnect the call. By clicking Yes, you can 
end the connection and exit Sprint Connection Manager. (See “Exiting 
Sprint Connection Manager” on page 44.)

If you have enabled GO automatically when ready, manually disconnecting will 
leave the device disconnected. It will not reconnect until one of the following 
occurs:

� You make a connection through Sprint Connection Manager

� A GPS fix is successfully acquired after you initiate Location-Based Services 
(page 40)

� You have selected Enable NIC for data connections and you remove and reinsert 
the device

� You have not selected Enable NIC for data connections and you restart 
Sprint Connection Manager

Online Help

Sprint Connection Manager includes extensive online help to provide operating 
hints and step-by-step instructions for getting the most from your Sprint Mobile 
Broadband USB modem.

With Sprint Connection Manager running, you can access online help in several 
ways:

� Press <F1> in any window.

� From the Sprint Connection Manager window, select MENU > Help.

� Right-click the system tray icon ( ) and select Help.

� Click the Help button available in many windows.

The help file has a table of contents and an index.
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Displaying Your Phone Number

You can view your phone number in the Device Info & Diagnostics window 
(Menu > Device Info & Diagnostics).

Security

When it is disconnected, you can lock your Sprint Mobile Broadband USB modem 
so that others cannot use the device and your account. A four-digit lock code is 
needed to unlock the device.

You can set the Sprint Mobile Broadband USB modem to lock: 

� Whenever Sprint Connection Manager is started (page 51), or 

� Immediately (without restarting Sprint Connection Manager) — useful if you 
are lending your Sprint Mobile Broadband USB modem and PC or leaving it for a 
short time (page 51).

Initial Lock Code 

The initial lock code value is determined by your service provider. 

For service provider configurations that do not require account activation, a 
default lock code is set at the factory to a value determined by the service 
provider. For assistance, contact Sprint (page 27). 

Configurations that use the Activation Wizard set the initial lock code to the last 
four digits of your account phone number whenever a new phone number is 
activated.

After activation, you can change the lock code (page 53) from the initial value to 
any four-digit code you choose. (See “Warning Regarding the Lock Code” below.)

Warning Regarding the Lock Code

If you lock the Sprint Mobile Broadband USB modem and forget the lock code, you 
will not be able to use the device until you receive assistance from Sprint.

Note: The security lock code is reset to the last four digits of the phone number 
whenever an account is activated. This may change a custom value you 
have set.
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When the Sprint Mobile Broadband USB Modem Is Locked

When the Sprint Mobile Broadband USB modem is locked, you can:

� Unlock the device (page 52).

� Power off the device (page 42).

When the device is locked, you cannot:

� Make data connections (the GO button is unavailable).

� Use Location-Based Services.

� Run the Activation Wizard.

Locking the Device

To lock the Sprint Mobile Broadband USB modem immediately: 

1. End any active connection. (You can lock the device only when it is 
disconnected; page 36.)

2. If Sprint Connection Manager is not expanded, click  to expand it.

3. Click the  icon.

4. In the Enter User Lock Code window, enter the lock code, and click OK.

When the device is locked, Sprint Connection Manager displays “Device locked,” 

and the lock icon is now . The GO button is unavailable.

Locking Upon Sprint Connection Manager Startup
To set the Sprint Mobile Broadband USB modem to lock as soon as Sprint Connection 
Manager starts up: 

1. End any active connection. (You can lock the device only when disconnected; 
see page 36.)

2. If Sprint Connection Manager is not expanded, click  to expand it.

3. Click the lock icon (  or , depending on the current lock status).

Warning: If you forget the lock code, you will not be able to use the device until you 
receive assistance from Sprint.

Tip: You can also set the device to be locked upon startup of Sprint Connection 
Manager, as described next.
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4. In the Enter User Lock Code window, enter the lock code, and select Relock 
modem when program exits.

5. Click OK.

Unlocking the Device

When the device is locked, Sprint Connection Manager displays “Device locked,” 

and the lock icon is .

To unlock the device: 

1. If Sprint Connection Manager is not expanded, click  to expand it.

2. Click the  icon.

3. In the Enter User Lock Code window, enter the lock code, and click OK.

When the device is unlocked, Sprint Connection Manager no longer displays 

“Device locked,” and the lock icon is .

Note: This setting takes effect only after you exit and restart Sprint Connection 
Manager.
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Changing the Lock Code

To change the lock code:

1. In the Sprint Vision settings window, click User Lock Change.

The Change User Lock Code window is displayed:

2. Enter the current lock code.

3. Enter a new four-digit lock code.

4. Enter the new lock code for confirmation.

5. Click OK.

Accessing Links

For your convenience, Sprint Connection Manager includes links to Sprint products 
and services. To access these links:

1. In Sprint Connection Manager, click Menu.

2. Select Links.

Warning:  If you forget the lock code, you will not be able to use the device until you 
receive assistance from Sprint.

Note: You cannot add or remove links from the Links menu. To add or remove 
links, use your Web browser.



54 Section 3A: Your Sprint Mobile Broadband USB Modem: The Basics

Uninstalling the Sprint Connection Manager Software

To remove the Sprint Connection Manager software from your computer, use the 
Add/Remove Programs utility built into your Windows operating system.

1. Exit Sprint Connection Manager (page 44).

2. Remove the Sprint Mobile Broadband USB modem. (See “Removing the 
Sprint Mobile Broadband USB Modem” on page 20.)

3. Select Start > Control Panel and select:

(Windows Vista) Programs and Features.
(Windows XP or Windows 2000) Add/Remove Programs.

The Windows Add/Remove Programs utility will start. Be sure the Change or 
Remove Programs feature is selected (default).

4. From the list, select Sprint Mobile Broadband (Sierra), and click Remove or 
Uninstall.
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Sec tion 3B

Menu Options

In This Section

� Sprint Connection Manager Menu

� System Tray Menu

This chapter describes each menu option you may encounter while using your 
Sprint Mobile Broadband USB modem and the Sprint Connection Manager 
software.
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Sprint Connection Manager Menu

Clicking Menu or the  button, located in the upper left corner of 
Sprint Connection Manager, displays the Sprint Connection Manager menu.

The following table describes the menu options:

Note: Depending on your configuration and settings, not all menu options may be 
shown or enabled as described here.

Tip: You can also display the menu by positioning the cursor over the Menu text 
or  button and then pressing the spacebar or Enter key on your keyboard. 
To hide the menu, press Esc, or click outside the menu.

Menu Item Description

Alert Log View a record of all alerts (for example, connection errors) 
that have been received while establishing and maintaining 
connections. 

See “Viewing Alerts” on page 71.

Connection 
History

View a record of connections established using your 
Sprint Mobile Broadband USB modem (unavailable if the 
Connection History is empty, or if Keep Connection History 
[page 62] is not selected).

See “Viewing the Connection History” on page 70.
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Device Info & 
Diagnostics

View information about your Sprint Mobile Broadband 
USB modem and run diagnostic tests. 

See “Running Diagnostics” on page 72.

Power Off 
Modem

Power off your Sprint Mobile Broadband USB modem.

See “Powering the Device On and Off” on page 42.

Location & 
Search 
Services

Query the network for information on points of interest that 
are near your current location.

See “Location-Based Services” on page 40.

Software 
Updates

Retrieve updates for Sprint Connection Manager and your 
Sprint Mobile Broadband USB modem. 

See “Updating the Software” on page 74.

Links  Access links to Sprint products and services. 

See “Accessing Links” on page 53.

Help Display the online Help, which has operating hints and step-
by-step instructions for getting the most from your 
Sprint Mobile Broadband USB modem. 

See “Online Help” on page 49.

About 
Sprint Mobile 
Broadband

Display brief information about the Sprint Connection 
Manager software. To close the window, click anywhere inside 
it. 

See “About Sprint Mobile Broadband” on page 75.

Settings Change the settings for Sprint Connection Manager. Contains 
submenu items:

� General: See “General Settings” on page 61.

� Sprint Vision - Sierra Wireless: See “Sprint Vision Settings” on 
page 63.

� Sprint Location Services: See “Sprint Location Services 
Settings” on page 66.

Exit  Exits Sprint Connection Manager.

Menu Item Description
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System Tray Menu

When you right-click the system tray icon ( ), a shortcut menu is displayed:

The following table describes the menu options:

Menu Item Description

Open/Close 
Sprint Mobile 
Broadband

Minimize Sprint Connection Manager (Close), or restore 
(Open) if Sprint Connection Manager is minimized.

Help Display the online Help.

About 
Sprint Mobile 
Broadband

Display brief information about the Sprint Connection 
Manager software. To close the window, click anywhere 
inside it.

Exit Exit Sprint Connection Manager.
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Sec tion 3C

Changing the Settings of Sprint Connection Manager

In This Section

� Settings Window

� General Settings

� Sprint Vision Settings

� Sprint Location Services Settings

This chapter describes the windows from which you can change the settings for 
Sprint Connection Manager.
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Settings Window

From the Settings window, you can specify the settings for Sprint Connection 
Manager.

1. In Sprint Connection Manager, click Menu.

2. Select Settings.

3. From the drop-down list, select one of the following categories of settings:

� General (general behavior of Sprint Connection Manager)

� Sprint Vision - Sierra Wireless (behavior of your Sprint Power Vision/
Sprint Vision connection)

� Sprint Location Services

4. Make the appropriate changes to the settings (described in the following 
pages).

5. To change other settings, repeat steps 3 and 4.

6. Click OK.

Note: Temporarily unavailable, if you have powered off the device (page 42).

Note: Changes to the setting Launch Connection Manager automatically apply only 
after you restart Windows. Changes to the setting Start in system tray apply 
only after you exit and restart Sprint Connection Manager.

Tip: You can also access the Settings window from the Connection History 
window (page 70): click File > Settings.
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General Settings

From the General option of the Settings window, you can specify settings that 
affect the general behavior of Sprint Connection Manager.
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The following table describes the options:

Menu Item Description

Play sound 
effects

Play a clicking sound whenever an action is made in 
Sprint Connection Manager.

Always on 
top

Keep Sprint Connection Manager visible on your screen 
regardless of which applications are open.

Start in 
system tray

Have Sprint Connection Manager start (minimized) in the system 
tray on startup. (See “Restoring Sprint Connection Manager” 
on page 44.)

Keep 
Connection 
History

Have Sprint Connection Manager keep a log of your data 
connections (page 70).

Launch 
Connection 
Manager 
automatically

Have Sprint Connection Manager start automatically (when 
your device is detected).

Tip: You can also set the Sprint Power Vision or Sprint Vision 
connection to launch automatically whenever available (see “GO 
automatically when ready” on page 64). These settings provide an 
“always-on” connection, as long as you have network coverage.

Check for 
updates once 
per month

Have Sprint Connection Manager automatically check for 
software updates (page 74).

Check Now Check for software updates immediately.

Note: During the software update, Sprint Connection Manager will 
close. Before you initiate the software update, finish any Web 
browsing, data transfers, and so on.

Note: Changes to the setting Launch Connection Manager automatically apply only 
after you restart Windows. Changes to the setting Start in system tray apply 
only after you exit and restart Sprint Connection Manager.
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Sprint Vision Settings

From the Sprint Vision option of the Settings window, you can change the 
behavior of your Sprint Power Vision or Sprint Vision connection.
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The following table describes the options:

Menu Item Description

Always show 
Welcome 
Screens

Display a welcome screen upon a successful connection to the 
network.

GO 
automatically 
when ready

Automatically connect to the network after Sprint Connection 
Manager starts, or whenever Sprint Connection Manager 
loses the network connection.

Tip: You can also set Sprint Connection Manager to start 
automatically (see “Launch Connection Manager automatically” on 
page 62). These settings provide an “always-on” connection, as long 
as you have network coverage.

You can have a connection established automatically, without 
having to run Sprint Connection Manager. Select Enable NIC for data 
connections (below) and GO automatically when ready. 

Enable NIC 
for data 
connections

Make a connection automatically, without running 
Sprint Connection Manager—simply by starting whatever 
application you want to use (such as your Web browser or 
email application).

Note: GO automatically when ready must also be selected.
Location-Based Services are available only when Sprint Connection 
Manager is running.

Network 
Mode: 
Automatic

Attempt a Sprint Power Vision (1xEV-DO) connection and, if 
not successful, attempt the slower Sprint Vision (1X) 
connection.

Network 
Mode: 
1xEV-DO 
Only

Attempt only a Sprint Power Vision (1xEV-DO) connection.

Note: When in an area that has only Sprint Vision (1X) coverage, you 
won’t be able to connect to the network.

Network 
Mode: 
1X Only

Attempt only a Sprint Vision (1X) connection (even when you 
are in Sprint Power Vision [1xEV-DO] coverage, which provides 
faster data transmission speeds).

Note: When in an area that has only Sprint Power Vision (1xEV-DO) 
coverage, you won’t be able to connect to the network.

Roam Mode: 
Sprint

Disable roaming when Sprint coverage is unavailable. You will 
be able to connect only when Sprint coverage is available.
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Roam Mode: 
Automatic

Allow roaming when Sprint coverage is unavailable.

Note: Roaming rates may apply. Roam Guard (page 46) can remind 
you of this.

Roam Mode: 
Roam Only

Allow only roaming.

Note: Roaming rates may apply. Roam Guard (page 46) can remind 
you of this.

Roam Mode: 
Roam Guard

Display a warning message when you are about to establish a 
data connection while roaming. For more information, see 
“Roam Guard” on page 46.

Available only if Roam Mode is set to Automatic (page 65).

Note: If you proceed with the data connection, roaming rates may 
apply.

Activation 
Wizard

Used only when activating a Sprint Mobile Broadband USB 
modem, or when changing your device’s phone number 
(page 23).

User Lock 
Change

Change the security lock code of the Sprint Mobile Broadband 
USB modem (page 53).

Auto Launch Optionally specify which application to automatically launch 
when a connection is established.

See “Auto-launch Upon Network Connection” on page 47.

Menu Item Description
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Sprint Location Services Settings

From the Sprint Location Services option of the Settings window, you can change 
the behavior of the Location-Based Services. (For more information on Location-
Based Services, see page 40.)
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The following table describes the options:

Menu Item Description

Enable 
Location on 
Device

Turn on support (by your device) for Location-Based Services.

Note: To use Location-Based Services,  your account must also be 
configured appropriately. If you are unable to use Location-Based 
Services, contact Sprint Customer Service (page 27).

Display 
'Location & 
Search 
Services' on 
the menu

Show or hide the Sprint Connection Manager menu item that 
displays  the Sprint Nextel Location & Search window. For 
more information on this window, see “Location-Based 
Services” on page 40.

Note: If you hide this menu item, you won’t be able to access Location-

Based Services.

Do not show 
Privacy 
Consent 
Agreement 
for 'Location 
& Search 
Services' 
menu

Prevent a Privacy Consent Agreement window from appearing 
every time you invoke Location-Based Services.

Microsoft Live

MapQuest

Yahoo! Maps

Google Maps

Specify which mapping and search service (for example, 
Microsoft® Live, or Google™ Maps) Internet Explorer uses for 
Location-Based Services.

Some mapping and search services may have data that is 
more current or accurate than that of other mapping and 
search services.
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Test GPS Verify that your device is able to obtain data for Location-
Based Services.

The results  (including the number of satellites, latitude, 
longitude, and elevation information) are displayed to the 
right of the Test GPS button.

Menu Item Description
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Section 3D

Tools

In This Section

� Viewing the Connection History

� Viewing Alerts

� Running Diagnostics

� Updating the Software

� About Sprint Mobile Broadband

This chapter describes various features you can use to view information about the 
Sprint Mobile Broadband USB modem and the Sprint Connection Manager 
software.
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Viewing the Connection History

Connection History displays a record of connections established using your 
Sprint Mobile Broadband USB modem. You can sort records by connection name 
to easily distinguish between personal and business usage.

From this window you can also access the Settings window (page 60) (File > 
Settings).

To view the Connection History:

1. In Sprint Connection Manager, click Menu.

2. Select Connection History.

To sort the entries:

� Click the button that contains the title of the column you want to sort by. (You 
can reverse the sort order by clicking the button again.)

– or –

Click an option under the Sort menu.

To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.

To copy one or more entry:

1. Select the entries. (Click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries; to select all entries, use Edit > Select All.)

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email message).

Note: For connections to be recorded, Keep Connection History must be enabled 
(page 62).
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To delete all entries:

� Click the Clear button.

To delete one or more entry:

1. Select the entries. (Click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries.)

2. Select Edit > Delete.

Viewing Alerts

The Alert Log displays a record of all alerts (for example, connection errors) that 
have been received while establishing and maintaining connections. You can use 
the Alert Log to help isolate and resolve connection issues.

To view the Alert Log:

1. In Sprint Connection Manager, click Menu.

2. Select Alert Log. (This menu option is unavailable if the alert log is empty.)

To sort the entries:

� Click the button that contains the title of the column you want to sort by. (You 
can reverse the sort order by clicking the button again.) 

– or –

Click an option under the Sort menu.

To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.
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To copy one or more entry:

1. Select the entries. (Click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries; to select all entries, use Edit > Select All.)

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email message).

To delete all entries:

� Click the Clear button.

To delete one or more entry:

1. Select the entries. (Click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries.)

2. Select Edit > Delete.

Running Diagnostics

To identify problems when connecting to the network, use the Device 
Info & Diagnostics window. Device Info & Diagnostics evaluates issues with your 
USB port, port configuration, network signal strength, Sprint Connection 
Manager, and more. Once the program runs a diagnostics check, it recommends 
solutions.

The program also displays information such as your phone number.

Results of the diagnostics can be shared with a Sprint Customer Service Specialist, 
to assist that person with troubleshooting.

To access the Device Info & Diagnostics window:

1. Ensure the Sprint Mobile Broadband USB modem is inserted.

2. In Sprint Connection Manager, click Menu.

3. Select Device Info & Diagnostics.
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The tests automatically start when the window opens.

From the Device Info & Diagnostics window, you can view system information 
(page 74) and save the system information to an RTF file.

From the Device Info & Diagnostics window, you can also update parameters in 
your Sprint Mobile Broadband USB modem:

� Click Update Data Profile. (If this button is not displayed, remove and reinsert 
the device.)
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Displaying System Information

The System Information window displays:

� System Parameters: Information about your computer hardware and software.

� Installed Files: Files related to Sprint Connection Manager.

� Device Info & Diagnostics: Information about the Sprint Mobile Broadband USB 
modem (including its phone number), and results of various tests.

To display system information:

1. Select Menu > Device Info & Diagnostics.

2. In the Device Info & Diagnostics window, click System Information.

To save the information to a file (for example, if you are requested to send the report to 
your service provider representative):

1. In the System Information window, click Create Report.

2. Specify a file name and path.

3. Click Save.

Updating the Software

From time to time, Sprint may release updates for Sprint Connection Manager and 
your Sprint Mobile Broadband USB modem. These updates may add features or 
improve network performance.

To update the software:

1. Ensure you have a network connection.

2. In Sprint Connection Manager, click Menu. Select Software Updates. 

– or –

From the General option of the Settings window (page 60), click Check Now.

You can also set the software to automatically check for updates once a month:

1. In Sprint Connection Manager, click Menu and then select Settings.

2. Select Check for updates once per month.

Note: During the software update, Sprint Connection Manager will close. Before 
you initiate the software update, finish any Web browsing, data transfers, 
and so on.
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About Sprint Mobile Broadband

The About Sprint Mobile Broadband window displays information about the 
Sprint Connection Manager software.

To display this window:

� In Sprint Connection Manager, click Menu and then select About Sprint Mobile 
Broadband. 

– or –

Right-click the Sprint Connection Manager icon ( ) in the system tray and, 
from the shortcut menu, select About Sprint Mobile Broadband.

To close this window, click anywhere inside it.

Tip: To display more information, you can run diagnostics (page 72).
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Sec tion 3E

Frequently Asked Questions

In This Section

� What is Sprint Connection Manager?

� If the connection is “always on,” am I always being billed?

� How fast is the connection with Sprint Connection Manager?

� Can I connect to a dial-up account like AOL or EarthLink?

� How do I get the location-enhanced Local Search feature?

� Where do I find the location-enhanced Local Search feature?

� How do I use the location-enhanced Local Search feature?

� Where can I use GPS?

� Once I connect to the network, how do I access my corporate network 
through a VPN?

� How can I optimize my settings to achieve the fastest speeds and 
conserve data when accessing my corporate network?

� Why won’t my laptop go into hibernation mode when using my 
Sprint Mobile Broadband USB Modem?
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What is Sprint Connection Manager?

Sprint Connection Manager is software that lets you connect to the Sprint Power 
Vision or Sprint Vision network. Sprint Connection Manager takes advantage of 
the increased data speeds offered by the Sprint Mobile Broadband Network.

If the connection is “always on,” am I always being billed?

No. The connection to the network goes dormant after a period of inactivity, but 
the connection can be re-established faster than having to reconnect. Billing 
occurs only when data is passed across the network.

How fast is the connection with Sprint Connection 
Manager?

The Sprint Mobile Broadband Network allows you to connect to the Internet at 
speeds of up to 3.1 Mbps (1xEV-DO Rev. A), 2.4 Mbps (1xEV-DO Rev. 0), or 144 kbps 
(1X). Average connection speeds are:
For 1xEV-DO Rev. A: between 450 and 800 kbps downlink from the network, and 
between 300 and 400 kbps uplink to the network;
For 1xEV-DO Rev. 0: between 400 and 700 kbps downlink from the network, and 
between 40 and 80 kbps uplink to the network;
For 1X: between 40 and 80 kbps.

These speeds are faster than dial-up connection speeds.

Can I connect to a dial-up account like AOL or EarthLink?

No. The software does not support dial-up connections.

How do I get the location-enhanced Local Search feature?

The location-enhanced Local Search feature works only with GPS-capable data 
cards and the latest version of Sprint Connection Manager. The feature is 
available at no additional charge in the latest version of Sprint Connection 
Manager.
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Where do I find the location-enhanced Local Search 
feature?

In Sprint Connection Manager, select Menu > Location & Search Services.

How do I use the location-enhanced Local Search feature?

When running Sprint Connection Manager, select Menu > Location & Search 
Services. Some predefined, most frequently used queries are listed. There is also an 
option to run your own custom query.

Where can I use GPS?

GPS works wherever there is both Sprint CDMA network access and GPS access.

Once I connect to the network, how do I access my 
corporate network through a VPN?

Once you complete a wireless connection, you may need to launch an extranet 
client provided by your company and supply the appropriate username and 
password to gain access. For support, contact your company help desk.

How can I optimize my settings to achieve the fastest 
speeds and conserve data when accessing my corporate 
network?

Depending on your corporate email client, you can optimize your settings by 
doing the following:

� Work in “offline” mode, and connect only when you need to send or receive 
email.

� Remove the Preview Pane, or use the AutoPreview for headers only.

Note: In some locations where CDMA network access is available, GPS may not 
be available at this time. For the latest on service available by location, 
refer to Sprint Nextel Coverage maps.
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� Save attachments to a desktop folder and then open from that folder, rather 
than opening the attachment directly from the message.

For more information, access the Microsoft white paper at:
www.microsoft.com/office/outlook/evaluation/perform.doc.

Why won’t my laptop go into hibernation mode when 
using my Sprint Mobile Broadband USB Modem?

If you’re using Windows 2000, you need to upgrade to Service Pack 4 from 
www.microsoft.com.

http://www.microsoft.com/office/outlook/evaluation/perform.doc
http://www.microsoft.com
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Sec tion 3F

Troubleshooting Tips

In This Section

� Problems, Causes, and Solutions

� GO Button Is Unavailable

� Searching for Service

� Cannot Connect to the Network

� Power LED Goes Off and On, and Then Stays Red

� Location-Based Services Don't Seem To Be Available

� Could Not Prepare Data Services

� Unable To Prepare Data Services

� Sprint Connection Manager Stops Working After Upgrading Windows

This section helps you diagnose and solve common problems you may experience 
while using your Sprint Mobile Broadband USB modem and the Sprint Connection 
Manager software.
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Problems, Causes, and Solutions

When properly installed, the Sprint Mobile Broadband USB modem is a highly 
reliable product.

Most problems are caused by one of these issues:

� Network coverage is not available (because of your “Network Mode” settings 
[page 63], or because you are outside the network, or because of an account or 
network problem).

� The drivers were not properly installed because of a problem with your 
computer’s USB slot.

� System resources required by the device are being used by other devices.

Tips when troubleshooting problems with your Sprint Mobile Broadband USB 
modem and software:

� Ensure your device is inserted, not locked (page 51), and not powered off 
(page 38).

� Ensure the Power LED is green.

� To determine the connection status, use the icons in the system tray (page 39), 
and icons and messages in Sprint Connection Manager (page 33 and page 35).

� The alert log might indicate the nature of the problem (page 71).

� Run diagnostic tools supplied with Sprint Connection Manager (page 72).

� Check the Frequently Asked Questions (page 76).

� Use the resources listed in “Getting Help” (page 26).

� Has Sprint Connection Manager stopped working after you’ve upgraded to a 
different version of Windows (page 85)?

If, after reading this section, you are unable to resolve a problem, please visit 
www.sprint.com or contact Sprint Customer Service. (See “Getting Help” on 
page 26.)

http://www.sprint.com
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GO Button Is Unavailable

Ensure the Sprint Mobile Broadband USB modem is properly inserted, not locked 
(page 51), and not powered off (page 38).

If Sprint Connection Manager displays “Searching for service” for a long period of 
time (for example, several minutes), see “Searching for Service” below.

If Roam Mode (from the Sprint Vision option of the Settings window) is set to 
Sprint, ensure you are not roaming, or change the setting (page 64). (You may be 
subject to roaming rates.)

Searching for Service

If Sprint Connection Manager displays “Searching for service” for a long period of 
time (for example, several minutes), try one of the following: 

� Try reorienting your computer, or try adjusting the angle of the device’s USB 
connector (see the picture on page 17).

� If you are inside a building or near a structure that may be blocking the signal, 
change the position or location of your computer.

� If Roam Mode (from the Sprint Vision option of the Settings window) is set to 
Sprint, ensure you are within the network coverage area, or change the Roam 
Mode setting. (You may be subject to roaming rates.)

� If Roam Mode (from the Sprint Vision option of the Settings window) is set to 
Roam Only, ensure you are roaming, or change the Roam Mode setting.

� If Network Mode (from the Sprint Vision option of the Settings window) is set to 
1X Only, and only 1xEV-DO coverage is available, either move to an area that 
has 1X coverage, or change the setting to Automatic or 1xEV-DO Only.

� If Network Mode (from the Sprint Vision option of the Settings window) is set to 
1xEV-DO Only, and only 1X coverage is available, either move to an area that 
has 1xEV-DO coverage, or change the setting to Automatic or 1X Only.

� Check with Sprint — a network or account problem may be preventing the 
Sprint Mobile Broadband USB modem from obtaining service.
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Cannot Connect to the Network

If you're having problems connecting, or there's no Sprint Power Vision (1x-EVDO) 
coverage in your area, set Network Mode (from the Sprint Vision option of the 
Settings window) to 1X Only, and try to establish a connection.

If the connection is dropped as soon as it is established:

� Charge the battery for at least 30 minutes if the Power LED is red. (If the 
connection still gets dropped as soon as it is established, continue with the 
following steps.)

– or –

1. Select:

(Windows Vista) Start > Control Panel > Network and Sharing Center > 
Manage Network Connections
(Windows XP) Start > Control Panel > Network Connections

(Windows 2000) Start > Settings > Control Panel > Network and Dial-Up 
Connections

2. Right-click Sprint Vision - Sierra Wireless, and select Properties.

3. Select:

(Windows Vista) Options, and select PPP Settings.
(Windows XP) Networking tab, and select Settings.

4. Ensure that “Enable LCP Extensions” is selected and “Negotiate multi-link for 
single link connections” is not selected.

5. Click OK.

Power LED Goes Off and On, and Then Stays Red

This situation may occur under extreme usage conditions when you’re 
transmitting data in a coverage area with a weak signal.

1. Wait until the Power LED turns green.

2. Resume your connection.

� If the Power LED still goes off, and then comes on again and stays red, charge 
the battery for at least 30 minutes.
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Location-Based Services Don't Seem To Be Available

If the menus or windows related to Location-Based Services are unavailable in 
Sprint Connection Manager:

� In the Settings window (page 60), check whether the drop-down list has a 
Sprint Location Services option.

If the drop-down list does not have the Sprint Location Services option, then your 
account, your device, or both are not configured to support Location-Based 
Services; contact Sprint Customer Service (page 27).

If the drop-down list has the Sprint Location Services option, select it and ensure 
that Enable Location on Device and Display 'Location & Search Services' on the menu 
are selected.

Could Not Prepare Data Services

See “Unable To Prepare Data Services” (page 84).

Unable To Prepare Data Services

The Sprint Mobile Broadband USB modem was unable to access the IOTA server to 
obtain data account parameters for you. This may be because the signal strength 
is poor or because the IOTA server is not responding.

� Confirm you have sufficient signal strength. Try the actions listed for 
“Searching for Service” (page 82).

� Contact Sprint for assistance (page 27).

This message may indicate that your system does not support 128-bit encryption 
for high-security access to data provisioning. You will not be able to complete the 
activation of data services until you upgrade your system’s security. (See “High 
Encryption Requirements” on page 9.)

Note: The message may appear as “Could not prepare data services. Please contact...”
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Sprint Connection Manager Stops Working After 
Upgrading Windows

If you’ve upgraded Windows, and Sprint Connection Manager stopped working:

1. Uninstall Sprint Connection Manager (page 54).

2. Reinstall Sprint Connection Manager (page 15).

Note: After the following steps, any changes you made to Sprint Connection 
Manager settings will be lost; you will have to re-apply the changes.
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Sec tion 4A

Technical Specifications

In This Section

� LED Operation

� Radio Frequency and Electrical Specifications

� Software Specifications

� Environmental Specifications

� Mechanical Specifications

This section describes the LED and various specifications of your Sprint Mobile 
Broadband USB modem.
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LED Operation

Your device has two LED lights. The LEDs operate as follows:

LED State Indicates

Data Off The device has no power. The device may not be 
completely inserted into the computer, the 
computer may be in suspend mode (which powers 
down the device), or you have powered the device 
off (page 42).

 Solid 
green

The device has power, has found a signal, and is 
ready to connect.

Green, 
blinking 
slowly

The device is powering up, or no service is available. 
See “Searching for Service” on page 82.

Green, 
blinking 
rapidly

The device is sending or receiving data.

Power Off The device has no power. The device may not be 
completely inserted into the computer, the 
computer may be in suspend mode (which powers 
down the device), or you have powered the device 
off (page 42).

Red The device has power; the battery is low.

Charge the battery by inserting the device into the 
USB slot of your computer. Alternatively, insert the 
device into the docking station, and attach the 
docking station to your computer.

Green The device has power; the battery is charged.
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Radio Frequency and Electrical Specifications

Approvals Compliant with:

IS-2000 Release 1.0 (CDMA (1X), IS-707-A Data, IS-856 
(CDMA 1xEV-DO), IS-866, IS-878, IS-890, 
CDMA Development Group

FCC (ID: N7N-MC5725U)

Industry Canada (ID: 2417C-MC5725U)

Voltage +5.0 Vdc from USB slot

Current Maximum:  500 mA (from USB port)

Typical data call current (talk mode), at 3.3 V:

285 mA (1X)

295 mA (1xEV-DO)

Standby: 2.75 mA (1xEV-DO/IS-2000 hybrid mode), 
at 3.3 V

Transmitter 
power

200 mW (+23 dBm)

Transmit PCS:  1805 to 1870 MHz

Cellular:  824 to 849 MHz

Receive PCS:  1715 to 1780 MHz

Cellular:  868 to 894 MHz

GPS:   1575.42 MHz

Channel 
spacing

1.25 MHz

Frequency 
stability

±150 Hz
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Software Specifications

CDMA 
specification

IS-2000 Release 0

Data service IS-707A

SMS (IS-637) Not supported

FAX Not supported

IOTA Supported

OTASP (IS-683A, 
IS-683B, IS-683C)

Supported

OTAPA Supported

PRL (preferred 
roaming list)

Supported

Authentication Supported

Voice Not supported

NAM Single

E911 Not supported

Position Location Supported (Mobile Station based)

TTY/Accessibility Not supported

Mobile IP Supported



Section 4A: Technical Specifications      93

Environmental Specifications

Mechanical Specifications

Operating 
temperature

-10 to +60°C

Storage 
temperature

-20 to +85°C

Humidity 85%, non-condensing

Vibration Random vibration, 10 to 1000 Hz, nominal 6G RMS in 
each of 3 mutually perpendicular axes.

Test duration of 60 minutes for each axis, for a total test 
time of 3 hours (non-operating).

Drop 1 m on concrete on each of 6 faces, 2 times

Dimensions
(W x L x H)

39 mm x 93 mm x 20 mm

Power button Not supported

Headset jack Not supported

LED Red/green
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Sec tion 4B

Regulatory Information

In This Section

� Regulatory Notices

� Patents

� Trademarks

� Copyright

� Limitation of Liability

� Additional Information and Updates

This section contains important regulatory notices about your Sprint Mobile 
Broadband USB modem, and also patent and other information.
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Regulatory Notices

The design of the AirCard 595U USB modem complies with U.S. Federal 
Communications Commission (FCC) and Industry Canada (IC) guidelines 
respecting safety levels of radio frequency (RF) exposure for portable devices, 
which in turn are consistent with the following safety standards previously set by 
Canadian, U.S. and international standards bodies:

� ANSI / IEEE C95.1-1999, IEEE Standard for Safety Levels with Respect to Human 
Exposure to Radio Frequency Electromagnetic Fields, 3kHz to 300 GHz

� National Council on Radiation Protection and Measurements (NCRP) Report 86, 
1986, Biological Effects and Exposure Criteria for Radio Frequency 
Electromagnetic Fields

� Health Canada, Safety Code 6, 1999, Limits of Human Exposure to Radio 
frequency Electromagnetic Fields in the Frequency Range from 3 kHz to 300 GHz

� International Commission on Non-Ionising Radiation Protection (ICNIRP) 1998, 
Guidelines for limiting exposure to time-varying electric, magnetic, and 
electromagnetic fields (up to 300 GHz)

FCC ID: N7N-MC5725U

CAUTION: The AirCard 595U USB modem has been tested for compliance with 
FCC/IC RF exposure limits in the laptop computer(s) configurations with a 
horizontal USB slot and can be used in laptop computers with substantially similar 
physical dimensions, construction, and electrical and RF characteristics. This USB 
modem must not be colocated or operated in conjunction with any other antenna 
or transmitter. Use of this device in any other configuration may exceed the FCC RF 
Exposure compliance limit. Note: If this USB modem is intended for use in any 
other portable device, you are responsible for separate approval to satisfy the SAR 
requirements of Part 2.1093 of FCC rules.

WARNING (EMI) - United States FCC Information - This equipment has been tested 
and found to comply with the limits for a class B computing device peripheral, 
pursuant to Parts 15, 22, and 24 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communication. However, there is no guarantee that 
interference will not occur in a particular installation.
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If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

� Reorient or relocate the receiving antenna

� Increase the separation between the equipment and receiver

� Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected

� Consult the dealer or an experienced radio/TV technician for help

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
condition that this device does not cause harmful interference.

CAUTION: Any changes or modifications not expressly approved by Sprint 
Communications Company L.P. could void the user’s authority to use the 
equipment.

WARNING (EMI) - Canada: This digital apparatus does not exceed the Class B limits 
for radio noise emissions from digital apparatus as set out in the interference 
causing equipment standard entitled “Digital Apparatus,” ICES-003 of the 
Department of Communications.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables 
aux appareils numériques de Classe B préscrites dans la norme sur le matériel 
brouilleur: “Appareils Numériques,” NMB-003 édictée par le ministre des 
Communications.

If you have purchased this product under a United States Government contract, it 
shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of Defense 
Federal Acquisitions Regulations (DFARs) Section 252.227-7013 for Department of 
Defense contracts, and as set forth in Federal Acquisitions Regulations (FARs) 
Section 52.227-19 for civilian agency contracts or any successor regulations. If 
further government regulations apply, it is your responsibility to ensure 
compliance with such regulations.
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Patents

Portions of this product are covered by some or all of the following US patents:

5,515,013 5,629,960 5,845,216 5,847,553 5,878,234

5,890,057 5,929,815 6,169,884 6,191,741 6,199,168

6,339,405 6,359,591 6,400,336 6,516,204 6,561,851

6,643,501 6,653,979 6,697,030 6,785,830 6,845,249

6,847,830 6,876,697 6,879,585 6,886,049 6,986,171

6,985,757 7,023,878 7,053,843 7,106,569 D442,170 

D459,303 

and other patents pending.

Licensed by QUALCOMM Incorporated under one or more of 
the following United States patents and/or their counterparts 
in other nations:

4901307 5056109 5101501 5109390 5228054

5267261 5267262 5337338 5414796 5416797

5490165 5504773 5506865 5511073 5535239

5544196 5568483 5600754 5657420 5659569

5710784 5778338

Manufactured or sold by Sierra Wireless or its licensees under one or more patents 
licensed from InterDigital Group.
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Trademarks

Sprint, the “Going Forward” logo, and other trademarks are trademarks of 
Sprint Nextel. 

AirCard® and “Heart of the Wireless Machine”® are registered trademarks of Sierra 
Wireless.

Sierra Wireless, the Sierra Wireless logo, Watcher, and the red wave design are 
trademarks of Sierra Wireless.

Windows® is a registered trademark of Microsoft Corporation.

Mac OS is a trademark of Apple Inc., registered in the U.S. and other countries.

QUALCOMM® is a registered trademark of QUALCOMM Incorporated.

InstallShield® is a registered trademark and service mark of InstallShield 
Corporation.

All other trademarks are property of their respective owners.

Copyright

©2007 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. Sprint, the “Going Forward” logo, and other 
trademarks are trademarks of Sprint Nextel.

©2007 Sierra Wireless. All rights reserved.

Document 2130751 Revision 2.0
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Limitation of Liability

The information in this manual is subject to change without notice and does not 
represent a commitment on the part of Sierra Wireless. SIERRA WIRELESS AND ITS 
AFFILIATES SPECIFICALLY DISCLAIM LIABILITY FOR ANY AND ALL DIRECT, INDIRECT, 
SPECIAL, GENERAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY 
DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR REVENUE OR 
ANTICIPATED PROFITS OR REVENUE ARISING OUT OF THE USE OR INABILITY TO USE 
ANY SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS AND/OR ITS AFFILIATES 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR THEY ARE 
FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY.

Notwithstanding the foregoing, in no event shall Sierra Wireless and/or its 
affiliates aggregate liability arising under or in connection with the Sierra Wireless 
product, regardless of the number of events, occurrences, or claims giving rise to 
liability, be in excess of the price paid by the purchaser for the Sierra Wireless 
product.

Additional Information and Updates

For up-to-date product descriptions, documentation, application notes, firmware 
upgrades, troubleshooting tips, and press releases, visit:

www.sierrawireless.com

http://www.sierrawireless.com
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Sec tion 5A

Safety and Notices

In This Section

� Important Notice

� Safety and Hazards

This section describes important guidelines regarding your Sprint Mobile 
Broadband USB modem.
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Important Notice

Because of the nature of wireless communications, transmission and reception of 
data can never be guaranteed. Data may be delayed, corrupted (i.e., have errors) or 
be totally lost. Although significant delays or losses of data are rare when wireless 
devices such as the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) CDMA modem are used in a normal manner with a well-
constructed network, they should not be used in situations where failure to 
transmit or receive data could result in damage of any kind to the user or any 
other party, including but not limited to personal injury, death, or loss of property. 
SPRINT SPECTRUM L.P. accepts no responsibility for damages of any kind resulting 
from delays or errors in data transmitted or received using the Sprint Mobile 
Broadband USB modem by Sierra Wireless (AirCard 595U) CDMA modem, or for 
failure of the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) to transmit or receive such data.

Safety and Hazards

Do not operate the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) in areas where blasting is in progress, where explosive 
atmospheres may be present, near medical equipment, life support equipment, or 
any equipment which may be susceptible to any form of radio interference. In 
such areas, the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) MUST BE POWERED OFF. It can transmit signals that could interfere 
with this equipment.

Do not operate the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) in any aircraft, whether the aircraft is on the ground or in flight. In 
aircraft, the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) MUST BE POWERED OFF. When operating, it can transmit signals 
that could interfere with various onboard systems.

The driver or operator of any vehicle should not operate the Sprint Mobile 
Broadband USB modem by Sierra Wireless (AirCard 595U) while in control of a 
vehicle. Doing so will detract from the driver or operator's control and operation of 
that vehicle. In some jurisdictions, operating such communications devices while 
in control of a vehicle is an offense.

To avoid the risk of explosion, use the same battery model when replacing the 
battery. Properly dispose of the used battery.
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Section 5B

Terms and Conditions

In This Section

� Subscriber Agreement/General Terms and Conditions of Services

This section contains the terms and conditions of service for your Sprint Mobile 
Broadband USB modem.



106 Section 5B: Terms and Conditions

Subscriber Agreement
General Terms and Conditions of Services

Please note these terms may not be the most current version. A current version of 
the terms is available at our Web site or upon request.

Para solicitar esta literatura en español, por favor visitar a www.sprint.com.

Basic Definitions

In this document: (1) “we,” “us,” “our” mean Sprint Solutions, Inc. and its affiliates 
doing business as Sprint or Sprint PCS; (2) “you,” “your,” “customer,” and “user” 
mean an account holder or user with us; (3) “Device” means any phone, device, 
accessory or other product we sell to you or that is active on your account with us; 
and (4) “Service” means our offers, rate plans, options, wireless services or Devices 
on your account with us.

The Subscriber Agreement

The Subscriber Agreement (“Agreement”) is a contract under which we provide 
and you accept our Services. In addition to these Terms and Conditions of Service 
(“Ts&Cs”), there are several parts to the Agreement, including, but not limited to, 
the detailed plan or other information on Services we provide or refer you to 
during the sales transaction, and any confirmation materials we may provide you. 
It is important that you carefully read all of the terms of the Agreement.

Services Covered By These Ts&Cs & Additional Terms

These Ts&Cs apply to our standard wireless Services and any other Service we 
offer you that references these Ts&Cs. Different terms will apply to most business 
accounts. Additional terms will apply when you use certain Services, typically 
those you can access online (for example, picture/video Services, online forums, 
etc.). Additional terms will also apply if you activate Services as part of a bundle 
with another company’s services (for example, cable services, home phone 
services, etc.). The additional terms for bundled Services may either modify or 
replace certain provisions in these Ts&Cs, including terms relating to activation, 
invoicing/payment, and disputing charges. Also, a different dispute resolution 
provision may apply to services provided by another company (the dispute 
resolution provisions in this Agreement still apply to our Services). You will be 
provided details on any additional terms with your selection of any bundled 
Service.

http://www.sprint.com
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Our Policies

Services are subject to our business policies, practices and procedures (“Policies”), 
including, but not limited to, our Privacy Policy and Acceptable Use Policy and 
Visitor Agreement – both available at our Web site. You agree to all of our Policies 
when you use our Services. Our Policies are subject to change at anytime with or 
without notice.

When You Accept The Agreement

You must have the legal capacity to accept the Agreement. You accept the 
Agreement when you do any of the following: (a) sign a contract with us on paper 
or electronically; (b) accept Agreement through an oral or electronic statement; (c) 
attempt to or in any way use the Services; (d) pay for the Services; or (e) open any 
package or start any program that says you are accepting the Agreement when 
doing so. If you don’t want to accept the Agreement, don’t do any of these things.

Term Commitments & Early Termination Fees

Many of the Services (for example, rate plans and Device discounts) that we offer 
require you to maintain certain Services with us for a minimum term, usually 1 or 
2 years (“Term Commitment”). You will be charged a fee (“Early Termination Fee”) for 
each line of Service that you terminate early (i.e., prior to satisfying the Term 
Commitment) or for each line of Service that we terminate early for good reason (for 
example, violating the payment or other terms of the Agreement). Early Termination 
Fees are a part of our rates. Your exact Term Commitment and Early Termination 
Fee may vary based on the Services you select and will be disclosed to you during 
the sales transaction. Carefully review any Term Commitment and Early Termination 
Fee requirements prior to selecting Services. After you have satisfied your Term 
Commitment, your Services continue on a month-to-month basis without any 
Early Termination Fee, unless you agree to extend your Term Commitment or 
agree to a new Term Commitment – for example, by accepting a new rate plan or 
upgrading your Device. As explained directly below, there are instances when you 
will not be responsible for an Early Termination Fee for terminating Services early.

When You Don’t Have To Pay An Early Termination Fee

You aren’t responsible for paying an Early Termination Fee when terminating 
Services: (a) provided on a month-to-month basis; (b) consistent with our 
published trial period return policy; or (c) in response to a materially adverse 
change we make to the Agreement as described directly below.
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Our Right To Change The Agreement & Your Related Rights

We may change any part of the Agreement at any time, including, but not limited to, 
rates, charges, how we calculate charges, or your terms of Service. We will provide you 
notice of material changes, and may provide you notice of non-material changes, in a 
manner consistent with this Agreement (see “Providing Notice Under This Agreement” 
paragraph). Except as provided below, if a change we make to the Agreement is 
material and has a material adverse effect on you, you may terminate each line of 
Service materially affected without incurring an Early Termination Fee only if you: 
(a) call us within 30 days after the effective date of the change; and (b) specifically 
advise us that you wish to cancel Services because of a material change to the 
Agreement that we have made. If you do not cancel Service within 30 days of the 
change, an Early Termination Fee will apply if you terminate Services before the 
end of any applicable Term Commitment.

Our Right To Suspend Or Terminate Services

We can, without notice, suspend or terminate any Service at any time for any reason, 
including, but not limited to: (a) late payment; (b) exceeding an Account Spending 
Limit (“ASL”); (c) harassing/threatening our employees or agents; (d) providing 
false information; (e) interfering with our operations; (f) using/suspicion of using 
Services in any manner restricted by or inconsistent with the Agreement; 
(g) breaching the Agreement, including our Policies; (h) providing false, 
inaccurate, dated or unverifiable identification or credit information, or becoming 
insolvent or bankrupt; (i) modifying a Device from its manufacturer 
specifications; or ( j) if we believe the action protects our interests, any customer’s 
interests or our network.

Your Ability To Change Services & When Changes Are Effective

You typically can change Services upon request. In some instances, changes may 
be conditioned on payment of an Early Termination Fee or certain other charges, 
or they may require you to accept a new Term Commitment. Changes to Services 
are usually effective at the start of your next full invoicing cycle. If the changes 
take place sooner, your invoice may reflect pro-rated charges for your old and 
new Services.

Your Right To Terminate Services

You can terminate Services at any time by calling us and requesting that we 
deactivate all Services. You’re responsible for all charges billed or incurred prior to 
deactivation. If Services are terminated before the end of your invoicing cycle, we 
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won’t prorate charges to the date of termination and you won’t receive a credit or 
refund for any unused Services. Except as provided above, you must also pay us an 
Early Termination Fee for each line of Service that you terminate early.

Credit Checks & Credit Information

We agree to provide you Services on the condition you have and maintain 
satisfactory credit according to our standards and policies. You agree to provide 
information we may request or complete any applications we may provide you to 
facilitate our review. We rely on the credit information you furnish, credit bureau 
reports or other data available from commercial credit reference services, and 
other information (such as payment history with us) to determine whether to 
provide or continue to provide you Services. The Services we offer you can vary 
based on your credit history. We may at any time, based on your credit history, 
withdraw or change Services, or place limits or conditions on the use of our 
Services. You agree to provide us updated credit information upon request. 
We may provide your payment history and other account billing/charge 
information to any credit reporting agency or industry clearinghouse.

Account Spending Limits (“ASL”)

An ASL is a temporary or permanent limit (typically based on credit history, 
payment history, or to prevent fraud) we place on the amount of unpaid charges 
you can accumulate on your account, regardless of when payment on those 
charges is due. We reserve the right to determine which charges count towards an 
ASL. If you have an ASL, we may suspend your Services without prior notice if your 
account balance reaches the ASL, even if your account is not past due. We may 
impose or increase an ASL at any time with notice. An ASL is for our benefit only 
and should not be relied on by you to manage usage.

Deposits & Returning Deposits

We may at any time require a deposit, as a guarantee of payment, for you to 
establish or maintain Service (“Deposit”). By providing us a Deposit, you grant us a 
security interest for all current or future amounts owed to us. We may change the 
Deposit at any time with notice. You can’t use a Deposit to make or delay 
payments. The Deposit, the length of time we hold the Deposit, and changes to 
the Deposit are determined based on your credit history, payment history and 
other factors. Unless prohibited by law, we may mix Deposits with our other funds 
and it won’t earn interest and we reserve the right to return the Deposit as a 
credit on your invoice at anytime. If your Services are terminated for any reason, 
we may keep and apply your Deposit to any outstanding charges. We’ll send any 
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remaining portion of Deposit to your last known address within 90 days after your 
final invoice – if it is returned to us, we will forward it on to the appropriate state 
authorities to the extent required by law.

Restrictions On Using Services

You can’t use our Services: (a) to transmit content/messages that are, or in any 
manner that is, illegal, fraudulent, threatening, abusive, defamatory, or obscene; 
(b) in a way that could cause damage or adversely affect our customers, 
reputation, network, property or Services; (c) to communicate any unsolicited 
commercial voice, text, SMS, or other message; (d) to infringe on the copyright of 
another, or upload or transmit any “virus”, “worm”, or malicious code; or (e) in any 
way prohibited by the terms of our Services, the Agreement or our Policies.

Your Device, Number & E-mail Address; Caller ID

We don’t manufacture any Device we might sell to you or that is associated with 
our Services, and we aren’t responsible for any defects, acts or omissions of the 
manufacturer. The only warranties on your Device are the limited warranties given to 
you by the manufacturer directly or that we pass through. Your Device is designed 
exclusively for use on our network and in other coverage areas we make available 
to you. It will not accept wireless service from another carrier. Except for any legal 
right you may have to port/transfer your phone number to another carrier, you 
have no and cannot gain any (for example, through publication, use, etc.) 
proprietary, ownership or other rights to any phone number, identification 
number, e-mail address or other identifier we assign to you, your Device or your 
account. We’ll notify you if we decide to change or reassign them.

Porting/Transferring Phone Numbers

We don’t guarantee that number transfers to or from us will be successful. If you 
authorize another carrier to transfer a number away from us, that is considered a 
request by you to us to terminate all of the Services associated with that number. 
You’re responsible for all charges billed or incurred prior to deactivation and for 
any applicable Early Termination Fees.

Coverage; Where Your Device Will Work

Our coverage maps are available at our stores and at our Web site. The specific 
network coverage you get will depend on the radio transmissions your Device can 
pick up and Services you’ve chosen. Our coverage maps provide high level estimates 
of our coverage areas when using Services outdoors under optimal conditions. 
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Coverage isn’t available everywhere. Estimating wireless coverage and signal strength 
is not an exact science. There are gaps in coverage within our estimated coverage areas 
that, along with other factors both within and beyond our control (network problems, 
software, signal strength, your Device, structures, buildings, weather, geography, 
topography, etc.), may result in dropped and blocked connections, slower data speeds, 
or otherwise impact the quality of Service. Services that rely on location information, 
such as E911 and GPS navigation, depend on your Device’s ability to acquire satellite 
signals (typically not available indoors) and network coverage.

Roaming

“Roaming” typically refers to coverage on another carrier’s network that we make 
available to you based on our agreements with other carriers. These agreements 
may change from time to time and roaming coverage is subject to change. Your 
ability to receive roaming coverage depends on the radio transmissions your 
Device can pick up. You can pick up roaming coverage both within and outside our 
network coverage areas. Your Device will generally indicate when you’re roaming. 
Depending on your Services, separate charges or limits on the amount of minutes 
used while roaming may apply. Certain Services may not be available or work the 
same when roaming (including data Services, voicemail, call waiting, etc.).

About Data Services & Content

Our data Services and your Device may allow you to access the internet, text, 
pictures, video, games, graphics, music, email, sound and other materials (“Data 
Content”) or send Data Content elsewhere. Some Data Content is available from 
us or our vendors, while other Data Content can be accessed from others (third 
party Web sites, games, ringers, etc.). We make absolutely no guarantees about 
the Data Content you access on your Device. Data Content may be: (1) unsuitable for 
children/minors; (2) unreliable or inaccurate; or (3) offensive, indecent or objectionable. 
You’re solely responsible for evaluating the Data Content accessed by you or anyone on 
your account. We strongly recommend you monitor data usage by children/minors. 
Data Content from third parties may also harm your Device or its software. To 
protect our network, Services, or for other reasons, we may place restrictions on 
accessing certain Data Content (such as certain Web sites, applications, etc.), 
impose separate charges, limit throughput or the amount of data you can 
transfer, or otherwise limit or terminate Services. If we provide you storage for 
Data Content you have purchased, we may delete the Data Content with notice or 
place restrictions/limits on the use of storage areas. You may not be able to make 
or receive voice calls while using data Services.
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Specific Terms & Restrictions On Using Data Services

In addition to the rules for using all of our other Services, unless we identify the 
Service or Device you have selected as specifically intended for that purpose (for 
example, wireless routers, Data Link, etc.), you can’t use our data Services: (1) with 
server devices or host computer applications, or other systems that drive 
continuous heavy traffic or data sessions; and (2) as a substitute or backup for 
private lines or frame relay connections. We reserve the right to limit or suspend 
any heavy, continuous data usage that adversely impacts our network 
performance or hinders access to our network. If your Services include unlimited 
web or data access, you also can’t use your Device as a modem for computers or 
other equipment, unless we identify the Service or Device you have selected as 
specifically intended for that purpose (for example, with “phone as modem” 
plans, connection card plans, wireless router plans, etc.).

Activation & Miscellaneous Charges

Based on our Policies, we may charge activation, prepayment, reactivation, 
program or other fees to establish or maintain Services. Certain transactions may 
also be subject to a charge (for example, convenience payment, changing phone 
numbers, handset upgrades, etc.). You will be provided notice of these types of 
fees before we complete the requested transaction.

Account & Service Charges; Pro-rating; Unused Minutes

You are responsible for all charges associated with your account and the Services on 
your account, no matter who uses the Services. Charges include, but are not limited 
to, the monthly recurring charges, usage charges, taxes, surcharges and fees 
associated with your Services. These charges are described or referred to during 
the sales transaction, in our marketing materials, and in confirmation materials 
we may send to you.

How We Calculate Your Charges For Billing Purposes

Regular Voice Calls: We round up partial minutes of use to the next full minute. 
Time starts when you press “Talk” or your Device connects to the network and 
stops when you press “End” or the network connection otherwise breaks. You’re 
charged for all calls that connect, even to answering machines. You won’t be 
charged for unanswered calls or if you get a busy signal. For incoming calls 
answered, you’re charged from the time shortly before the Device starts ringing 
until you press “End” or the network connection otherwise breaks. If charges vary 
depending on the time of day that you place or receive calls (e.g., Nights and 
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Weekend plans), you’re charged for the entire call based on the rate that applies 
to the time period in which the call starts.

iDEN Walkie-Talkie Charges: Charges for walkie-talkie calls are billed to the person 
who starts the call and calculated by multiplying the duration of the call by the 
applicable rate and number of participants. You’re charged at least 6 seconds of 
airtime for each call you start; subsequent communications in the same call are 
rounded up to and billed to the next second. Time begins when you press any 
button to start a walkie-talkie call and ends approximately 6 seconds after 
completion of a communication to which no participant responds – subsequent 
walkie-talkie communications are considered new calls. Depending on your plan, 
nationwide, international or group walkie-talkie calls may use the local walkie-
talkie minutes in your plan and result in additional charges. Responses to call alert 
transmissions are treated as new walkie-talkie transmissions even when 
responding within 6 seconds of receiving the alert.

Data Usage: Unless we specifically tell you otherwise, data usage is measured in 
bytes, kilobytes and megabytes – not in minutes/time. 1024 bytes equals 
1 kilobyte (“KB”), and 1024 KB equals 1 megabyte. Bytes are rounded up to 
kilobytes, so you will be charged at least 1 KB for each data usage session (“data 
session”). Rounding occurs at the end of each data session, and sometimes during 
a data session. Depending on your data Services, usage may be charged against an 
allowance or on a fixed price per KB. If you are charged on a fixed price per KB, any 
fractional cents will be rounded up to the next cent. You are charged for all data 
directed to your Device’s internet address, including data sessions you did not 
initiate and for incomplete transfers. As long as your Device is connected to our 
data network, you may incur data charges. Examples of data you will be charged 
for includes the size of a requested file or Data Content (game, ringer, etc.), web 
page graphics (logos, pictures, banners, advertisement, etc.), additional data used 
in accessing, transporting and routing the file on our network, data from partial or 
interrupted downloads, re-sent data, and data associated with unsuccessful 
attempts to reach Web sites or use applications. These data charges are in 
addition to any charges for the Data Content itself (game, ringer, etc.). Data used 
and charged to you will vary widely, even between identical actions or data 
sessions. Estimates of data usage – for example, the size of downloadable files – 
are not reliable predictors of actual usage. Your bill won’t separately list the 
number of KB attributed to a specific action/data session.
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Your Bill

Your bill provides you notice of your charges. It reflects monthly recurring charges 
(usually billed one bill cycle in advance) and usage/transaction specific charges 
(usually billed in the bill cycle in which they’re incurred). Some usage charges, 
such as those that depend on usage information from a third party, may be billed 
in subsequent bill cycles and result in higher than expected charges for that 
month. Bill cycles and dates may change from time to time. Your bill may also 
include other important notices (for example, changes to this Agreement, to your 
Service, legal notices, etc.). Your paper bill may not include individual call detail. 
Your call detail is available online. Paper bills with call detail may be subject to an 
additional charge. If you choose internet billing, you will not receive paper bills.

Your Payments; Late Fees

Payment is due in full as stated on your bill. If we do not receive payment in full by 
the date specified on your bill, a late payment charge, which may be charged at 
the highest rate permissible by law, may be applied to the total unpaid balance. 
We may also charge you any costs we pay to a collection agency to collect unpaid 
balances from you. If we bill you for amounts on behalf of a third party, payments 
received are first applied to our charges. You may be charged additional fees for 
certain methods of payment. We may charge you, up to the highest amount 
permitted by law, for returned checks or other payments paid by you and denied 
for any reason by a financial institution. Acceptance of payments (even if marked 
“paid in full”) does not waive our right to collect all amounts that you owe us. We 
may restrict your payment methods to cashier’s check, money order, or other 
similar secure form of payment at any time for good reason.

Taxes & Government Fees

You agree to pay all federal, state and local taxes, fees and other assessments that 
we’re required by law to collect on the Services we provide you and remit to the 
government. These charges may change from time to time without advance 
notice. If you’re claiming any tax exemption, you must provide us with a valid 
exemption certificate. Tax exemptions generally won’t be applied retroactively.

Surcharges

You agree to pay the surcharges, fees and other charges that we assess to recoup 
our government costs or costs of complying with certain government programs 
(“Surcharges”). Surcharges aren’t taxes or government mandated charges; they’re 
charges we choose to collect from you. Surcharges are subject to change, sometimes on 
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a monthly or quarterly basis. Examples of Surcharges include, but are not limited to: 
Universal Service Fund, E911, Federal Programs Cost Recovery, Federal Wireless 
Number Pooling and Portability, and gross receipts charges. We will make efforts 
to provide you notice of any changes to Surcharges in a manner consistent with 
this Agreement (see “Providing Notice Under This Agreement” paragraph). 
However, since most Surcharges are based on amounts set by the government or 
based on government formulas, it will not always be possible to provide advance 
notice of new Surcharges or changes in the amount of existing Surcharges. 
Information on Surcharges is provided during the sales transaction and is 
available at our Web site.

Disputing Charges - You Must Still Pay Undisputed Charges

Any dispute to a charge on your bill must be made within 60 days of the date of 
the bill that initially contained the charge. Disputes can only be made by calling or 
writing us as directed on your invoice or elsewhere. You accept all charges not 
properly disputed within the above time period – undisputed charges must still be 
paid as stated on your bill.

Protecting Our Network & Services

We can take any action to: (1) protect our network, our rights and interests, or the 
rights of others; or (2) optimize or improve the overall use of our network and 
Services. Some of these actions may interrupt or prevent legitimate 
communications and usage – for example, message filtering/blocking software to 
prevent SPAM or viruses, limiting throughput, limiting access to certain Web sites, 
applications or other Data Content, etc. For additional information on what we do 
to protect our customers, network, Services and equipment, see our Acceptable 
Use Policy and Visitor Agreement at our Web site.

Your Privacy

You agree to the terms of our Privacy Policy, available at our Web site, when you 
use our Services. This policy may change from time to time, so review this policy 
with regularity and care. Among other things, the policy includes important 
information on what information we collect about you, how we use that 
information, and with whom we share that information (for example, to provide 
you certain Services, to protect our rights and interests, to respond to legal 
process, to facilitate a merger, etc.). Also, to ensure the quality of our Services and 
for other lawful purposes, we may also monitor or record calls between us (for 
example, your conversations with our customer service or sales departments). 
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If you do not agree with the terms of our Privacy Policy, do not purchase or use 
our Services.

Location Based Services

Our network generally knows the location of your Device when it is outdoors and 
turned on. By using various technologies to locate your Device, we can provide 
enhanced emergency 911 services, and optional location-sensitive services 
provided by us or a third party. Environmental factors (such as structures, 
buildings, weather, geography, landscape, and topography) can significantly 
impact the ability to access your Device’s location information and use of 
location-sensitive services. The terms and conditions of any location-sensitive 
service that you purchase from us may provide more information about how 
location information is used and disclosed. Use of some of location-sensitive 
services may require network coverage. If any Device on your account uses a 
location-sensitive service, you (the accountholder) must clearly and regularly notify the 
actual user of your Device that their location may be tracked or discovered. For 
additional information on location-sensitive services, see our Privacy Policy at our 
Web site.

911 Or Other Emergency Calls

Public Safety Officials advise that when making 911 or other emergency calls, you 
should always be prepared to provide your location information. Unlike traditional 
wireline phones, depending on a number of factors (e.g., whether your Device is 
GPS enabled, where you are, whether local emergency service providers have 
upgraded their equipment, etc.), 911 operators may not know your phone 
number, your location or the location of your Device. In certain circumstances, an 
emergency call may be routed to a state patrol dispatcher or alternative location 
set by local emergency service providers. Enhanced 911 service (“E911”), where 
enabled by local emergency authorities, uses GPS technology to provide location 
information. Even when available, however, E911 does not always provide 
accurate location information. If your Device is indoors or for some other reason 
cannot acquire a satellite signal, you may not be located. Some Devices have a 
safety feature that prevents use of the keypad after dialing 911 – you should 
follow voice prompts when interacting with emergency service providers 
employing IVR systems to screen calls.

If Your Device Is Lost or Stolen

Call us immediately if your Device is lost or stolen because you may be responsible 
for usage charges before you notify us of the alleged loss or theft. You agree to 
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cooperate if we choose to investigate the matter (provide facts, sworn 
statements, etc.). We may not waive any Early Termination Fees if you choose to 
terminate Services as a result of loss or theft of your Device.

Disclaimer of Warranties

WE MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING (TO THE EXTENT ALLOWED BY LAW) ANY IMPLIED WARRANTY OF 
MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR 
PURPOSE CONCERNING YOUR SERVICES (INCLUDING YOUR DEVICE). WE DON’T 
PROMISE UNINTERRUPTED OR ERROR-FREE SERVICES AND DON’T AUTHORIZE 
ANYONE TO MAKE WARRANTIES ON OUR BEHALF.

You Agree We Are Not Responsible For Certain Problems

You agree that neither we nor our vendors, suppliers or licensors are responsible 
for any damages resulting from: (a) anything done or not done by someone else; 
(b) providing or failing to provide Services, including, but not limited to, 
deficiencies or problems with a Device or network coverage (for example, 
dropped, blocked, interrupted calls/messages, etc.); (c) traffic or other accidents, 
or any health-related claims relating to our Services; (d) Data Content or 
information accessed while using our Services; (e) an interruption or failure in 
accessing or attempting to access emergency services from a Device, including 
through 911, Enhanced 911 or otherwise; (f) interrupted, failed, or inaccurate 
location information services, (g) information or communication that is blocked 
by a spam filter, or (h) things beyond our control, including acts of God (for 
example, weather-related phenomena, fire, earthquake, hurricane, etc.), riot, 
strike, war, terrorism or government orders or acts.

You Agree Our Liability Is Limited - No Consequential Damages.

TO THE EXTENT ALLOWED BY LAW, OUR LIABILITY FOR MONETARY DAMAGES FOR 
ANY CLAIMS YOU MAY HAVE AGAINST US IS LIMITED TO NO MORE THAN THE 
PROPORTIONATE AMOUNT OF THE SERVICE CHARGES ATTRIBUTABLE TO THE 
AFFECTED PERIOD. UNDER NO CIRCUMSTANCES ARE WE LIABLE FOR ANY 
INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR SPECIAL DAMAGES OF ANY NATURE 
WHATSOEVER ARISING OUT OF OR RELATED TO PROVIDING OR FAILING TO 
PROVIDE SERVICES IN CONNECTION WITH A DEVICE, INCLUDING, BUT NOT 
LIMITED TO, LOST PROFITS, LOSS OF BUSINESS, OR COST OF REPLACEMENT 
PRODUCTS AND SERVICES.
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DISPUTE RESOLUTION
We Agree To First Contact Each Other With Any Disputes

We each agree to first contact each other with any disputes and provide a written 
description of the problem, all relevant documents/information and the proposed 
resolution. You agree to contact us with disputes by calling or writing us as 
instructed on your invoice. We will contact you by letter to your billing address or 
on your Device.

Instead Of Suing In Court, We Each Agree To Arbitrate Disputes

We each agree to finally settle all disputes (as defined and subject to any specific 
exceptions below) only by arbitration. In arbitration, there’s no judge or jury and 
review is limited. However, just as a court would, the arbitrator must honor the 
terms and limitations in the Agreement and can award the same damages and 
relief, including any attorney’s fees authorized by law. The arbitrator’s decision 
and award is final and binding, with some exceptions under the Federal 
Arbitration Act (“FAA”), and judgment on the award may be entered in any court 
with jurisdiction. We each also agree as follows:

(1) “Disputes” are any claims or controversies against each other related in any way to 
our Services or the Agreement, including, but not limited to, coverage, Devices, privacy, 
or advertising, even if it arises after Services have terminated – this includes claims 
you bring against our employees, agents, affiliates or other representatives, or 
that we bring against you.

(2) If either of us wants to arbitrate a dispute, we agree to send written notice to 
the other providing a description of the dispute, previous efforts to resolve the 
dispute, all supporting documents/information, and the proposed resolution. 
Notice to you will be sent to your billing address and notice to us will be sent to: 
General Counsel; Arbitration Office; 2001 Edmund Halley Drive VARESP0513-502; 
Reston, Virginia 20191. We agree to make attempts to resolve the dispute. If we 
cannot resolve the dispute within forty-five (45) days of receipt of the notice to 
arbitrate, then we may submit the dispute to formal arbitration.

(3) The FAA applies to this Agreement and arbitration provision. We each agree 
the FAA’s provisions, not state law, govern all questions of whether a dispute is 
subject to arbitration.

(4) The arbitration will be administered by the International Institute for Conflict 
Prevention and Resolution (“CPR”) under its arbitration rules. If any of the CPR’s 
rules conflict with the terms of the Agreement, the terms of the Agreement apply. 
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You can obtain procedures, rules, and fee information from the CPR at 
1-212-949-6490 or www.cpradr.org.

(5) Unless we each agree otherwise, the Arbitration will be conducted by a single 
neutral arbitrator and will take place in the county of your last billing address. The 
federal or state law that applies to the Agreement will also apply during the 
arbitration.

(6) We each agree not to pursue arbitration on a classwide basis. We each agree that 
any arbitration will be solely between you and us (not brought on behalf of or together 
with another individual’s claim). If for any reason this restriction is found 
unenforceable, then our agreement to arbitrate doesn’t apply.

(7) We each are responsible for our respective costs relating to counsel, experts, 
and witnesses, as well as any other costs relating to the arbitration. However, we 
will cover any arbitration administrative or filing fees above: (a) $25 if you are 
seeking less than $1,000 from us; or (b) the equivalent court filing fees for a court 
action in the appropriate jurisdiction if you are seeking $1,000 or more from us.

Exceptions To Our Agreement To Arbitrate Disputes

Either of us may bring qualifying claims in small claims court. In addition, this 
arbitration provision does not prevent you from filing your dispute with any 
federal, state or local government agency that can, if the law allows, seek relief 
against us on your behalf.

http://www.cpradr.org
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No Class Actions

TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO PURSUE 
DISPUTES ON A CLASSWIDE BASIS; THAT IS, TO EITHER JOIN A CLAIM WITH THE 
CLAIM OF ANY OTHER PERSON OR ENTITY, OR ASSERT A CLAIM IN A 
REPRESENTATIVE CAPACITY ON BEHALF OF ANYONE ELSE IN ANY LAWSUIT, 
ARBITRATION OR OTHER PROCEEDING.

No Trial By Jury

TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO TRIAL BY JURY 
IN ANY LAWSUIT, ARBITRATION OR OTHER PROCEEDING.

Indemnification

You agree to indemnify, defend and hold us harmless from any claims arising out 
of your actions, including, but not limited to, failing to provide appropriate notices 
regarding location-sensitive services (see “Location Based Services” paragraph), or 
violating this Agreement, any applicable law or regulation or the rights of any 
third party.

Providing Notice To Each Other Under The Agreement

Except as the Agreement specifically provides otherwise, you must provide us 
notice by calling or writing us as instructed on your invoice. We will provide you 
notice in your bill, correspondence to your last known billing address, to any fax 
number or e-mail address you’ve provided us, by calling you on your home phone 
or Device, by voice message on your Device or home phone, or by text message on 
your Device.

Other Important Terms

Subject to federal law or unless the Agreement specifically provides otherwise, 
this Agreement is governed solely by the laws of the state encompassing the area 
code assigned to your Device, without regard to the conflicts of law rules of that 
state. If either of us waives or doesn’t enforce a requirement under this 
Agreement in an instance, we don’t waive our right to later enforce that 
requirement. Except as the Agreement specifically provides otherwise, if any part 
of the Agreement is held invalid or unenforceable, the rest of this Agreement 
remains in full force and effect. This Agreement isn’t for the benefit of any 3rd 
party except our corporate parents, affiliates, subsidiaries, agents, and 
predecessors and successors in interest. You can’t assign the Agreement or any of 
your rights or duties under it. We can assign the Agreement. The Agreement and 
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the documents it incorporates make up the entire agreement between us and 
replaces all prior written or spoken agreements – you can’t rely on any 
contradictory documents or statements by sales or service representatives. The 
rights, obligations and commitments in the Agreement that, by their nature, 
would logically continue beyond the termination of Services (including, but not 
limited to, those relating to billing, payment, 911, dispute resolution, no class 
action, no jury trial), survive termination of Services.

© 2007 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. Sprint, the “Going Forward” logo and other 
trademarks are trademarks of Sprint Nextel. iDEN is a trademark of Motorola, Inc.
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Glossary

1X
One Times Radio Transmission Technology (the “one times” refers to the 
frequency spectrum). Also known as Sprint Vision. Supports Internet connections 
with data rates up to 153 kbps. Actual speed depends on the network conditions. 
Compare to 1xEV-DO.

1xEV-DO
A high-speed standard for cellular packet data communications. Also known as 
Sprint Power Vision.

1xEV-DO Rev. A supports Internet connections with data rates up to 3.1 Mbps 
(downlink from the network) and 1.8 Mbps (uplink to the network). Average data 
rates are 450-800 kbps (downlink from the network) and 300-400 kbps (uplink to 
the network).

1xEV-DO Rev. 0 supports Internet connections with data rates up to 2.4 Mbps 
(downlink from the network) and 153 kbps (uplink to the network). Average data 
rates are 400-700 kbps (downlink from the network) and 40-80 kbps (uplink to the 
network)

Actual speed depends on the network conditions. Compare to 1X.

bps
bits per second—The actual data speed over the transmission medium.

broadband
High-speed wireless services optimized for data. Sprint Mobile Broadband is the 
next evolutionary step for the Sprint Power Vision Network.

CDMA
Code Division Multiple Access—A wideband spread spectrum technique used in 
digital cellular, personal communications services, and other wireless networks. 
Wide channels (1.25 MHz) are obtained through spread spectrum transmissions, 
thus allowing many active users to share the same channel. Each user is assigned 
a unique digital code, which differentiates the individual conversations on the 
same channel.

dBm
decibels relative to 1 milliwatt
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dormant
The network switches the data connection into dormant mode if there is no traffic 
on the connection for some time. When you resume data traffic, the high-speed 
data connection becomes active.

ESN
Electronic Serial Number—The unique serial number assigned to the device for 
cellular network use. Either the ESN or MEID is on the label on the device (under 
the battery), and is also displayed in the Device Info & Diagnostics window 
(page 72). See also MEID.

FCC
Federal Communications Commission—The U.S. federal agency that is responsible 
for interstate and foreign communications. The FCC regulates commercial and 
private radio spectrum management, sets rates for communications services, 
determines standards for equipment, and controls broadcast licensing. Consult 
www.fcc.gov.

fix
GPS location information obtained from the network.

GPS
Global Positioning System—A system that uses a series of 24 geosynchronous 
satellites to provide location data.

IS
Interim Standard—After receiving industry consensus, the TIA forwards the 
standard to ANSI for approval.

kbps
kilobits per second—Actually 1000, not 1024, as used in computer memory size 
measurements of kilobytes.

LAN
Local Area Network

LED
Light Emitting Diode—A semiconductor diode that emits visible or infrared light.

Mbps
Megabits per second.

http://www.fcc.gov
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MEID
Mobile Equipment Identifier—The unique second-generation serial number 
assigned to the Sprint Mobile Broadband USB modem for cellular network use. 
Either the MEID or ESN is on the label on the device (under the battery), and is also 
displayed in the Device Info & Diagnostics window (page 72). Compare to ESN.

MHz
megahertz—One million cycles per second

PCS
Personal Communications Services—A cellular communication infrastructure.

roaming
A cellular subscriber is in an area where service is obtained from a cellular service 
provider other than Sprint.

Sprint Connection Manager
Software that allows you to manage the Sprint Mobile Broadband USB modem’s 
actions and monitor your connections.

Sprint Mobile Broadband
High-speed wireless services optimized for data. Sprint Mobile Broadband is the 
next evolutionary step for the Sprint Power Vision Network.

Sprint Power Vision
Sprint’s advanced multimedia third generation services available on the network. 
See 1xEV-DO.

Sprint Vision
Sprint’s advanced multimedia third generation services available on the network. 
See 1X.



128 Glossary

system tray
Usually located in the bottom right of the screen (near the clock). When 

Sprint Connection Manager is running, it places an icon  in this area, which you 
can use to monitor the connection state (page 39). If you right-click the icon, a 
shortcut menu is displayed (page 58):

TIA
Telecommunications Industry Association—A standards-setting trade organization, 
whose members provide communications and information technology products, 
systems, distribution services, and professional services in the United States and 
around the world. Consult www.tiaonline.org.

ToolTip
Text that displays when you position the mouse pointer over an area of the screen 
(for example, over an indicator).

VPN
Virtual Private Network

WAN
Wide Area Network

http://www.tiaonline.org
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Index
Symbols
  84

Numerics
1-888-211-4727  27
1X Only (Network Mode)  64
1X, 1xEV-DO

description  5
amount of data transferred  48
application to automatically launch upon 

network connection  47
automatically connecting when ready  64
cannot connect  83
connecting  45
coverage, determining  40
dormant indicator  34
ending a connection  49
icons  34
roaming indicator  34
transmit/receive indicator  34
warning when roaming  46

1xEV-DO Only (Network Mode)  64
3G

see 1X, 1xEV-DO

A
About Sprint Mobile Broadband  75
accessibility  92
account

accessing  27
setting up  22

Activating and Using Sprint Service  22
activating the device  22
activation  22
activation code  24
Activation Wizard

overview  22
Activation Wizard button  65

aircraft  42, 104
Alert Log  71
alerts  71
always on

description  5
billing  77
set  33

Always on top  62
Always show Welcome screens  64
Always-on connection  5

amount of data transferred  48
antenna, adjusting  17
AOL  77
approvals  91
assistance  27, 49
authentication  92
auto-launch Sprint Connection Manager  33
Auto-launch upon network connection  47
Automatic (Network Mode)  64
Automatic (roaming option)  65
automatically connecting to network  64
automatically starting Sprint Connection 

Manager  33
AutoPreview  78

B
basics  31
battery

warning  17
charging  18
inserting into device  17
replacing  10

behavior when the device is locked  51
billing, and always on  77
blasting  104
bookmarks  53
business usage  70

C
call duration  70
cannot connect to the network  83
care and maintenance  10
CDMA

networks  4
roaming - description  4
signal strength indicator  34
specification  92

changing the lock code  53
channel spacing  91
charging the battery  18
Check for updates once per month  62
Check Now button  62
Clear Log  71
Close Sprint Connection Manager  44
Close Sprint Mobile Broadband  44
compact view of Sprint Connection 

Manager  43
conditions of service  105
Connected  37
connected icon  39
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Connected to NDIS  37
Connecting  37
connecting  45
connecting automatically  64
connecting icon  39
connection

1X or 1xEV-DO (Network Mode)  64
alert log  71
Always-on  5
amount of data transferred  48
application to automatically launch upon 

network connection  47
automatically connecting when ready  64
cannot connect  83
diagnostics  72
ending  49
establishing  45
history  70
issues  71
launching  45
making  45
Network Mode  64
states  35, 39
warning when roaming  46

Connection History  70
Connection Manager

see Sprint Connection Manager
connection states  39
Consent Agreement for ’Location & Search 

Services’ menu  67
contents of package  6
Could not prepare data services  84
coverage maps  27
coverage type, determining  40
Create Report  74
current  91
customer support  27

D
Data LED  90
data profile  25
data provisioning  25
data speeds  77
data transferred, amount of  48
default connection  45
deleting Sprint Connection Manager  54
Device Info & Diagnostics  72
Device Locked  38
Device powered off  38, 42
device, powering off  42

diagnostics  72
dial-up account  77
dimensions  93
Disconnected  36
disconnected icon  39
disconnecting  49
disk space required  9
Display ’Location & Search Services’ on the 

menu  67
Displaying system information  74
Do not show Privacy Consent Agreement for 

’Location & Search Services’ menu  67
document number  98
dormant icon  39
driver installation  20
drop test  93

E
E911  92
editing

Sprint Connection Manager settings  60
Sprint Power Vision/Sprint Vision 

connection  63
electrical specifications  91
electronic serial number  24
elevation information  68
Enable Location on Device  67
Enable NIC for data connections  64
encryption - required for IOTA  9
ending a connection  49
environmental specifications  93
error messages - viewing  71
ESN  24
EV-DO. See 1X, 1xEV-DO.
exiting Sprint Connection Manager  44
expanded view of Sprint Connection 

Manager  43
expanding Sprint Connection Manager  43
explosion risk if incorrect battery used  17

F
FAQ  76
favorites  53
fax  92
FCC

compliance  95
ID  95

firmware upgrades  99
forgot the lock code  50
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frequencies, transmit and receive  91
frequency stability  91
Frequently Asked Questions  76

G
General options in Settings window  61
Getting Help  26
Getting Started  7
global positioning system (GPS). See 

Location & Search Services
glossary  125
GO automatically when ready  64
GO button  45
GO button is unavailable  82
Google Maps  67
GPS Testing  68
GPS. See Location & Search Services

H
hard drive space required  9
hardware requirements  9
hazards  104
headset jack  93
Help

overview  27
alert log  71
contact number  27
device info and diagnostics  72
diagnostics  72
frequently asked questions  76
menu options  55
online Help  49
Sprint Customer Service  27
Sprint.com  27
tests  72
troubleshooting  80

hibernation mode  79
high encryption  9
history  70
hospital  42
humidity  93

I
icons

Sprint Connection Manager  34
system tray  39

IMSI_S  24
indicators

Sprint Connection Manager  34
system tray  39

information, system  72

initial lock code  50
Initializing  36
inserting the device  20
installation

overview  7
Installed files  74

interference  42
Internet Over The Air  25
introduction  ii
invoice, requesting a copy of  27
IOTA (Internet Over The Air)

description  25
IOTA Provisioning window  25
Unable to prepare data services  84

K
Keep Connection History  62
knowledge base  27

L
latitude  68
Launch Connection Manager automatically  

62
LBS (Location-Based Services). See Location 

& Search Services
LEDs  90
liability, limitation of  99
life support equipment  104
light (LED)  90
Limitation of Liability  99
links, access  53
Location & Search Services

frequently asked questions  77
settings  66
troubleshooting  84
using  40

Location-Based Services. See Location & 
Search Services

lock code
overview  50
changing  53
initial lock code  50
warning  50

lock device
immediately  51
upon startup  51

locked device
behavior when the device is locked  51
changing the lock code  53
initial lock code  50
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unlocking the device  52
log, alert  71
log, connection  70
longitude  68

M
Mac OS X  8
maintenance  10
making a connection

1X or 1xEV-DO (Network Mode)  64
always on  64
amount of data transferred  48
application to automatically launch upon 

network connection  47
automatically  64
cannot connect  83
connecting to Sprint Power Vision/Sprint 

Vision  45
Network Mode  64

map services  67
Mapping and Search Service  67
MapQuest  67
maps, coverage  27
MDN  24
medical equipment  104
MEID  24
memory required  9
Menu

all options  55
About Sprint Mobile Broadband  75
Alert Log  71
Connection History  70
Device Info & Diagnostics  72
Exit  49
Links  53
Location & Search Services  40
Menu button  35
Settings  60
Software Updates  74
system tray menu  58

Menu button  35
menu options

Location & Search Services menu  40
Sprint Connection Manager menu  55
system tray menu  58

messages - viewing  71
Microsoft Live  67
Microsoft VPN (PPTP) Connection  47
minimizing Sprint Connection Manager

immediately  44
on startup  62

minus sign in Sprint Connection Manager  
43

Mobile IP  92
MS-Based position location  92
MSID (Mobile System ID)  23, 24

N
NAM  92
NDIS

Connected to NDIS  37
network

 See Sprint National Network
network interface card (NIC)  64
Network Mode  64
NIC  64
No device  36
non-preactivated device  23
non-preferred roaming area  34
notices - safety and regulatory  95, 103
number of satellites  68

O
on top, always  62
online Help  49
operating systems supported  8
operating temperature  93
optimizing performance  78
OTAPA  92
OTASP  92

P
package contents  6
patents  97
performance, improving  78
personal usage  70
phone number

during Activation Wizard  24
Sprint Mobile Broadband USB modem  50

planes  104
Play sound effects  62
plus sign (+) in Sprint Connection Manager  

43
port configuration  72
position location  92

See also Location & Search Services
power button  93
powering the device on and off  42
Power LED  90
Power Vision, Sprint (1xEV-DO). See 1X, 

1xEV-DO.
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powered off  38, 42
PPTP - Microsoft VPN (PPTP) Connection  47
preactivated device  22
preferred roaming list  92
Preview Pane  78
Privacy Consent Agreement  67
PRL  92
problems  80
products, Sprint  53
profile - data  25
properties of connection, changing  63
provisioning  22, 25

Q
questions

See troubleshooting

R
radio frequency specifications  91
receive frequencies  91
records of connection history  70
regulatory information  94
regulatory notices  95
Relock modem when program exits  51
removing Sprint Connection Manager  54
removing the device  20
report of system information  74
requirements, system  8
restoring Sprint Connection Manager  44
RF specifications  91
Roam Guard  46
Roam Mode  64
Roam Only (roaming option)  65
roaming

description  4
display warning message  46
indicator  34
PRL  92
settings  64

RSSI  34, 72
Running Diagnostics  72

S
Safety and Hazards  104
Safety and Notices  103
satellites, number of  68
Search Services  40, 67
Searching  38
Searching for service  36, 82
security

overview of user lock  50
warning  50
behavior when the device is locked  51
changing the lock code  53
high encryption - required for IOTA  9
IOTA - high encryption requirement  9
lock device immediately  51
lock device upon startup  51
unlocking the device  52

service plan, adding options  27
service, conditions of  105
service, searching for  82
services, Sprint  53
Setting Up Service  21
Settings window

overview  60
General  61
Sprint Location Services  66
Sprint Vision  63

shortcut menu  58
show Welcome screens  64
signal strength

diagnostic tests  72
indicator  34

SMS  92
software

components  10
lock device immediately  51
lock device upon startup  51
menu options  55
minimizing  44
minimizing on startup  62
removing  54
restore minimized  44
specifications  92
uninstalling  54
unlocking the device  52
updating  74
upgrading Windows  85
user lock  50
version information  75
Windows, upgrading  85

Software Updates  74
sound effects, play  62
specifications

environmental  93
mechanical  93
radio frequency and electrical  91
software  92

speeds, data transmission  77
Sprint (roaming option)  64
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Sprint Connection Manager
overview  32
1X or 1xEV-DO connection (Network 

Mode)  64
About Sprint Mobile Broadband  75
amount of data transferred  48
application to automatically launch upon 

network connection  47
automatically connecting when ready  64
cannot connect  83
closing  44
configuring  60
expanding Sprint Connection Manager  

43
FAQ  76
frequently asked questions  76
icons  34
icons in system tray  39
links  53
Location-Based Services  40
menu options  55
minimizing  44
minimizing on startup  62
Network Mode  64
removing  54
restoring  44
security features  50
settings  60
starting  32
starting automatically  33
stopped working after Windows upgrade  

85
system tray menu  58
uninstalling  54
updating  74
upgrading Windows  85
version information  75
window overview  33
Windows upgrade  85

Sprint Connection Manager settings
1X or 1xEV-DO connection (Network 

Mode)  64
changing  60
General  61
Sprint Location Services  66
Sprint Vision  63

Sprint Connection Manager stopped 
working after I’ve upgraded to a different 
version of Windows  85

Sprint Customer Service  27
Sprint Location Services

settings  66

troubleshooting  84
using  40

Sprint Mobile Broadband USB modem
inserting  20
phone number  50

Sprint National Network
1X or 1xEV-DO connection (Network 

Mode)  64
always on connection  64
amount of data transferred  48
application to automatically launch upon 

network connection  47
automatically connecting when ready  64
availability status  72
cannot connect  83
CDMA wireless network, description  4
connecting  45
coverage, determining  40
frequently asked questions  76
Location-Based Services  40
roaming indicator  34
roaming options  64
signal strength indicator  34

Sprint Power Vision (1xEV-DO).  See 1X, 
1xEV-DO.

Sprint products and services  53
Sprint roaming  64
Sprint services

Sprint Customer Service  27
Sprint Vision

1X or 1xEV-DO connection (Network 
Mode)  64

Always show Welcome screens  64
amount of data transferred  48
application to automatically launch upon 

network connection  47
automatically connecting when ready  64
cannot connect  83
connecting  45
coverage, determining  40
disconnecting  49
ending a connection  49
Network Mode  64
settings  63
warning when roaming  46
See also 1X, 1xEV-DO.

Sprint web site  27
Sprint, contacting  27
sprint.com  27
standby current  91
Start in system tray  62
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starting a connection
application to automatically launch upon 

network connection  47
automatically connecting when ready  64
immediately  45
specify 1X or 1xEV-DO connection 

(Network Mode)  64
warning when roaming  46

starting Sprint Connection Manager
automatically  33
manually  32

states of connection  35
status information  72
status of connection  35
Stop button  49
storage temperature  93
support  27
suspend mode  90
system information  72, 74
System parameters  74
system requirements  8
system tray

connection states  39
icons  39
menu  58
shortcut menu  58
start in  62

T
taskbar icon

shortcut menu  44
technical specifications  89
technical support  27
telephone number of device  50
temperature (operating, and storage)  93
Terms and Conditions  105
terms and definitions (glossary)  125
Test GPS  68
tests, diagnostic  72
trademarks  98
transferred data, amount of  48
transmission speeds  77
transmit frequencies  91
transmit/receive icon  34
transmitter power  91
troubleshooting

common causes of problems  81
alert log  71
cannot connect  83
contact information  27

Could not prepare data services  84
FAQ  76
GO button is unavailable  82
Location-Based Services  84
run diagnostic tests  72
searching for service  82
stopped working after Windows upgrade  

85
Troubleshooting wizard  27
Unable to prepare data services  84
wizard  27

Troubleshooting wizard  27
TTY  92
type of coverage, determining  40

U
uninstalling Sprint Connection Manager  54
unlocking the device

initial lock code  50
instructions  52

Update Data Profile  25
updates, checking for latest  99
updating the software  74
Updating User Profile…  25
upgrading Windows  85
URL to automatically launch upon network 

connection  47
URLs - favorites  53
USB port  72
user lock

overview  50
warning  50
changing the lock code  53
lock device immediately  51
lock device upon startup  51
unlocking the device  52

User Lock Change button  65

V
vehicle, operating  104
version information  75
vibration  93
Viewing your phone number  50
views of Sprint Connection Manager  43
Vision

see Sprint Vision, and 1X, 1xEV-DO
Vista  8
voice support  92
voltage  91
VPN  78
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VPN program to automatically launch upon 
network connection  47

W
warning

explosion risk if incorrect battery used  17
lock code, regarding  50
roaming, display message  46

warranty  6
weak signal  82
Web site

automatically launch upon network 
connection  47

favorites  53
Sprint.com  27

Welcome screen, always show  64
white paper  78
Windows

auto-launch Sprint Connection Manager  
62

upgrading  85
versions supported  8

wizard
Activation Wizard  22
Troubleshooting  27

www.sprint.com  27

Y
Yahoo! Maps  67
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